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Preface 
The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the 
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web 
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available 
on your network from which you can access the Agile PLM documentation (PDF) files. 

Note  To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > Manuals 
in both Agile Web Client and Agile Java Client. If you need additional assistance or information, 
please contact support http://www.oracle.com/agile/support.html 
(http://www.oracle.com/agile/support.html) for assistance. 

Note  Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  
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Chapter 1 

Product Quality Management 

This chapter includes the following: 

 Before you Begin ................................................................................................................................................. 1 
 What's New in PQM 9.3....................................................................................................................................... 1 
 An Overview of Product Quality Management..................................................................................................... 2 
 Product Service Requests ................................................................................................................................... 3 
 Quality Service Requests .................................................................................................................................... 3 
 Tracking Quality................................................................................................................................................... 4 

 
 

Before you Begin 
This manual guides you to use Agile Product Quality Management solution provided you have 
installed Agile PLM at your company. To install Agile PLM, use the appropriate installation 
documentation. To help you install Agile PLM and understand Agile objects, classes, their 
application and their working, refer to the manuals listed below: 

 Agile Database Installation Guide 

 Installing Agile PLM for OAS 

 Installing Agile PLM for WebLogic 

 Getting Started with Agile PLM 

 Agile PLM Administrator Guide 

Some common terms appear across all Agile PLM modules. For details, see the Getting Started 
with Agile PLM guide. 

What's New in PQM 9.3 
Changes across Agile PLM 9.3 User Interface have created a few changes in the PQM module as 
well. Listed below are generic enhanced features and links, which lead you to detailed 
documentation on some of the commonly used features of PQM. 

Enhanced generic features across Agile PLM: 

 Preview pane replaced by Quick View: The Quick View dialog appears when you position the 
cursor on any object and allows you to view details of the object and perform some actions.  

Enhanced Add feature allows y ou to add/remove objects faster by either drag and drop option 

 lize menu replace the filter option in the Web Client. See also: Relationships 

or the copy and paste option. 

Views and Persona
Table on page 42. 

v9.3 1

  



Product Quality Management User Guide  

 

 

 The Edit Rule button is now available on the Relationships table and the Quick View dialog. 

  Execute a Quick Search, Custom Search and the Advanced 

Commonly used features in Agile PQM: 

 Creating a PSR from an Item: Icon changes. Views and Personalize menu replaces the filter option 
in the Web Client.   

Search for PSRs and QCRs: The
Search results returns PSRs or QCRs matching the set criteria. For details, see Search for 
PSRs or QCRs on page 24.  

 ce existing files, create Creating PSR using Save As: Additional features now allow you to referen
new copies of the file or does not include files, when you copy PSRs with Attachments. See 
Step 5 of the instructions of Creating PSR using Save As on page 22. 

 Create a QCR from a PSR: Icon changes. Views and Personalize menu replace the filter option in
the Web Client. 

 

 Adding Items to the Affected Items tab of a PSR: You can add items to the Affected Items tab of a 
PSR using the Search/Create Button. See Search to add on page 30 to search for existing 
Items and Create to add on page 30 to create new Items. The enhanced Add feature allows 

 you to add objects faster by using the drag and drop option or the copy and paste option. See
also: Adding Items to the Affected Items tab of a PSR on page 30. 

 ures, the appearance of the 
 also in the Quick View dialog message bar. See also: 
 of a PSR

Adding Objects to the Relationships tab of a PSR: Enhanced add feat
Edit Rule on the Relationships table and
Adding Objects to the Relationships tab  on page 43. 
Adding Relationship Rules on page 46. 
Editing Relationship Rules on page 47. 

 view Quality 
issues on PSRs, QCRs, Customers and Suppliers.  
Viewing Quality issues a Customer and Supplier: Enhanced search results help you 

See also Viewing Quality issues against a Customer or Supplier on page 1
 

7. 

e 

t, and 
e PQM closes the support loop by unifying the company’s 

 at 
u 

f the 

and Quality Change 
Requests (QCRs). PSRs manage Problem Reports and Non-Conformance Reports. QCRs create 
and manage Audits, and Corrective and Preventive Actions (CAPAs). 

An Overview of Product Quality Management 
Agile PQM is a powerful solution currently in use across leading business organizations around th
globe. It involves an innovative methodology used to track and manage data, which translates to 
(better products) enhanced quality, productivity (lesser time cycles) and reliability (Zero failures). 
The flexibility of the solution adds to its inclusion across a number of business ventures. This 
includes customer complaints, product and manufacturing defects, field failures, enhancemen
corrective and preventive measures. Agil
customer service; field sales, manufacturing, and engineering organizations, and linking the 
company to its customers and partners. 

As alternate quality management packages enter the market, customers demand quality products
a lower cost, and a reduced product lifecycle. Quality incidents reported by the customers help yo
detect defects and resolve them responsively. Tracking defects and finding the root cause o
defects in a timely manner are keys to effective defect reduction and improving product quality.  

The Agile PQM solution consists of Product Service Requests (PSRs) 
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Product Service Requests 
Product Service Requests report quality incidents, and aggregate a number of other PSRs to a single 
PSR. The PSR class includes Problem Reports (PRs) and Non-Conformance Reports (NCRs). PRs 
report generic quality incidents and NCRs report material deviations from specifications and other 
specific quality issues. For details, see Working with Product Service Requests on page 19. 

Problem Reports 

A Problem Report contains a basic description of a quality issue, problem, or incident reported from a 
customer’s perspective. A customer, field service representative, or supplier may submit a Problem 
Report provided they hold the appropriate privilege to process a Problem Report. You need to route 
a Problem Report for inquiry through a workflow. The inquiry team determines the root cause of the 
problem. The user with Quality Analyst role oversees the processing of the problem reports. 

You use Agile Import or Agile SDK to import problem reports from different CRM systems. 

Non-Conformance Reports 

A customer, field service representative, or supplier may submit a Non-Conformance Report (NCR) to 
report a basic material deviation from specifications or requirements in one or more products. You 
also need to route Non-Conformance Reports through a workflow for an inquiry. 

Incoming inspection lots or testing processes use an NCR and the Quality Analyst checks samples 
for deviations from specifications. 

Quality Service Requests 
Quality Change Requests creates and manages Audits and Corrective and Preventive Actions 
(CAPAs). An audit is the pro-active process of verifying compliance with quality requirements. The 
CAPA is a formal process of addressing any generic quality problems and analyzing the root cause 
so you can implement corrective and preventive actions.  

QCRs allow you to aggregate problems into a routable quality record, perform root-cause failure 
analysis, and drive the problems to closure using standard CAPA (corrective and preventive 
actions) procedures. The CAPA may result in changes to a product, process, or supplier. 

You can use QCRs to: 

1. Create and manage quality records that aggregate problems related to products, documents, 
suppliers, and customers.  

2. Provide a means for driving quality-related changes by creating changes such as ECOs, 
MCOs, ECRs, stop ships, and deviations.  

3. Route change requests for review and approval, thereby enabling communication and 
collaboration between the originator (Quality Control), root-cause failure analysis (Quality 
Control and Engineering), resolution (Engineering), corrective/preventative action (Quality 
Management), communication (customers and suppliers) and verification (compliance/audit).  
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4. Provide an audit trail between problems, corrective and preventive actions, and engineering 
changes that enable internal and external compliance processes.  

For example, while conducting a quality check on the incoming lot of items from your supplier, you 
identify a defective item. To take corrective action, you create a QCR for the defective item and route 
it for review and approval. You can route the item through a change to ensure rectification of the 
defect and check for the latest revision of the item. 

For more details, see Working with Quality Service Requests on page 53. 

Audits 

An Audit is a pro-active process of verifying compliance with quality requirements. Default Audit 
workflows are different from CAPA workflows. For details, see Workflow tab of a QCR on page 61.  

Corrective and Preventive Actions 

Corrective and preventive actions (CAPAs) address generic quality problems for one or more PSRs. 
A CAPA could result in the creation of one or more changes that lead to fixing the problems. A 
CAPA is a routable object and a workflow controls it. CAPA workflows vary for different workflow 
statuses. For details, see Workflow tab of a QCR. 

Tracking Quality 
Tracking quality helps organizations identify, measure and improve business processes, which in 
turn leads to improved business performance and thus assures customer satisfaction. Monitoring 
non-conformance reports and implementing CAPAs help organizations meet standards. We look at 
some of the quality features that enable us to meet these standards. 

Tracking Quality Roles 

Product Quality Management provides these roles: 

Quality Analyst – The role of a Quality Analyst allows you to submit Problem Reports (PRs) and Non-
Conformance Reports (NCRs) and manage their resolution.    

Quality Administrator – The role of a Quality Administrator allows you to manage Audits and CAPAs.  

For details about Agile PLM roles, see the Agile PLM Administrator guide. 
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Tracking Quality Process 

The following diagram illustrates an example of a quality incident process. Following the diagram is 
a description of each numbered step. 

 
1. Two customers report quality incidents. Customer 1 and Customer 2 

2. The support division creates problem service requests (PSRs) for the reported incidents.  

3. PSR-1, PSR-2, PSR-3 for Customer 1. 
PSR-1, PSR-2, PSR-3 for Customer 2.  

4. Submits PSRs to the Quality Analyst, who reviews all the PSRs. 

5. Since all PSRs pertain to similar incidents even though they are from different customers, the 
Quality Analyst aggregates them to a single PSR and creates PSR-4. 

6. For further processing, routes PSR-4 through a workflow.  

7. The Quality Administrator creates a quality change request, QCR-1. The QCR includes a list of 
the items that it affects.  

8. Routes the QCR.  

9. The engineering team determines if the request is valid and merits a change (an ECO, MCO, 
and ECR, stop ship or deviation depending on the problem).  

10. Create a change to address the problem. The Change Analyst routes the change through the 
workflow.  

11. Changes implemented fix the problem. The Change Analyst sends a notification to the Quality 
Administrator, who checks if the change did address the problem documented in the QCR.  

12. The quality administrator takes action to close the QCR. 
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Quality Related SmartRules 

SmartRules are system wide settings that let you choose how to manage specific behaviors in Agile 
PLM. Agile Administrator can modify these settings. The following SmartRules relate to Product 
Quality Management processes: 

 Many Items per PSR 

 Many QCRs per PSR 

 PSR contains Items and Related PSRs 

 Release QCR with resolved Items. 

We take the example of PSR contains Items and Related PSRs SmartRule. 

The PSR contains Items and Related PSRs SmartRule controls the behavior of the Affected Items 
tab and the Related PSR tab of PSRs. If you set the SmartRule to Allow, PSRs can have both 
affected items and related PSRs. Otherwise, both Affected Items and related PSRs are mutually 
exclusive. In other words, if the Affected Items tab lists items, then the Related PSR tab is 
unavailable; and if Related PSR tab lists PSRs, then the Affected Items tab is unavailable. This 
allows you to choose whether to use a PSR as an aggregation of other PSRs or as a problem report 
against assembly items. 

For complete details on these and other SmartRules, see the Agile PLM Administrator guide. 

Quality Searches 

You can perform a search by selecting the required search from either the Quick Search or 
Advanced Search from the Quality Searches folder to find specific PSRs and QCRs. For example, if 
you are a Quality Administrator and need to assign all unassigned PSRs to Quality Analysts, you 
can do a quick search of all unassigned PSRs. Listed below are some of the sample quality 
searches: 

 Unassigned PSRs 

 Open PSRs 

e than X hours ago 

mitted QCRs 

Note  rches folder appears only if the Administrator has specified the searches 

 PSRs submitted more than X hours ago  

 QCRs submitted mor

 Released QCRs 

 Closed QCRs 

 Unassigned Sub

 Open QCRs 

The Quality Sea
in your profile. 
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Quality Reports 

Agile PLM provides several standard reports that help you analyze data in Agile PQM.    

In the navigation pane of the Agile Web Client, click Reports > Reports and Analytics > Standard Reports 
> Quality Reports. The Quality Reports lists the following reports: 

 Failure Trend Report on page 7 

 Quality Activity Report on page 9 

 Quality Backlog Report on page 11 

 Quality Cycle Time Report on page 13 

 Quality Metrics Report on page  15

Each of the above Reports takes you through a Report Wizard provided you hold the necessary 
privileges. Step through the wizard. At the end of the process a Report appears. You can print the 
report, export its content, or save it. Executed report outputs are visible only in Web Client. 

A Quality Report consists of the following tabs: 

General info - gives you the general details about the report. The Agile administrator sets the fields 
on the General info tab. 

Layout tab: In the Layout tab, you can add or edit fields in a standard or customized report layout, if 
required. You need appropriate privileges to edit the layout.  

Schedule: The Schedule tab allows you to run a report using a specific schedule, or on specific date 
and time.  

Historical Report: The Historical Report tab displays all previously run reports. It displays saved 
reports with the date, time and the name of the user who runs the report. 

History: The History tab shows a summary of actions taken on the report. 

For more details on the tabs of Quality Reports, see the Getting Started with Agile PLM guide.

Failure Trend Report 

The Failure Trend Report lists trends in failure mode over time. Based on the results, you can focus 
corrective efforts on those items that have the greatest effect on product quality.  

To produce a report of the quantities affected during the specified period, Product Service Requests 
must have a value specified in the Affected Items Quantity Affected field. Ensure to obtain the 
necessary privileges to execute a report.  

To run a Failure Report Trend: 

1. In the navigation pane, navigate to Reports > Reports and Analytics > Standard Reports > Quality 
Reports > Failure Trend Report.  

2. Click the Execute button.  

A Run Failure Trend Report wizard opens. 
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3. The Select Layout and Configuration page appears. Select a Layout from the list. 

a. Click the Edit  button to modify an existing layout. The Default Layout dialog opens. 
Modify the required fields. 

b. Select properties from the Hidden Fields column and move them to the Displayed Fields 
column using the right arrow. You can also place them in the required ascending or 
descending order using arrows. 

c. Click Save to save the changes or Close to close the palette. 

4. In the Properties frame,  
a. Enter a name in the Name field. 
b. Select the type of Access.   
c. Select the Paper Size from the list. 
d. Select the Orientation of the paper. 
e. Click Save to save the changes or Close to close the palette. 

5. Click the Create  button to create a new layout. The Layout Presentation palette opens.  

6. In the Format frame,  
a. Select properties from the Hidden Fields column and move them to the Displayed Fields 

column using the right arrow. You can also place them in the required ascending or 
descending order using arrows. 

b. Click Save to save the changes or Close to close the palette. 

7. In the Properties frame,  
a. Enter a name in the Name field. 
b. Select the type of Access.   
c. Select the Paper Size from the list. 
d. Select the Orientation of the paper. 
e. Click Save to save the changes or Close to close the palette. 

8. Select a format for the generated report from the Output Format list. You can choose from a list 
of formats - PDF, WORD, EXCEL, HTML, STANDARD.  

9. Select the Save a copy of the report in the historical reports check box to save the generated report. 

Note  The Save a copy of the report in the historical reports check box does not appear if you 
select the Standard output format. 

10. Click Next.  
11. The Select or Create a Query page appears. The Failure Trend Report lets you search for 

Product Service Requests to use in the report.   
a. Select the All Product Service Requests check box to choose from all the PSRs. 
b. Select the Saved Search check box to choose from existing PSRs.  

c. Click the Search  palette and choose a value from the Saved Searches list. 
d. Select the Advanced Search check box.  
e. Click Define Query. A Report Search palette opens. Choose from the list or enter the 

necessary details to define the query. 
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f. Click Clear to clear the selection, Finish to continue and Close to close the palette. 

Note  For details about the Search palette, see the Getting Started with Agile PLM guide. 

12. Click Next to proceed to the next step or Back to edit the Query. 

The Define Report page appears. 

13. In the Time Period frame:   
a. Click the calendar and select From date. 
b. Click the calendar and select To date. 
c. Select a Time Unit from the list.  

14. In the Additional Report Criteria frame:  
a. Select a value from the Trend By list. 
b. Select the check box to display the Product Service Requests. 
c. Select the check box to Exclude Empty Columns. 

15. Click Finish to display the report. 

16. A Get Attachment dialog prompts you to download the report.  

Click the buttons that appear at the top of the generated report to save, print, or export the report. 
The report is lost if you click the Close button, without saving it. 

Save: Saves the report to the Historical Report tab. 

Print: Prints the generated report. 

Export: Exports the content of the report to a delimited text file (CSV) or a Microsoft Excel workbook. 
 

Quality Activity Report 

The Quality Activity report lists quality incidents (product service requests and quality change 
requests) processed during a specified period. 

To run a Quality Activity Report:  

1. In the navigation pane, navigate to Reports > Reports and Analytics > Standard Reports > Quality 
Reports > Quality Activity Report.  

2. Click Execute.  

A Run Quality Activity Report wizard opens. 

3. The Select Layout and Configuration page appears. Select a Layout from the list. 

4. Click the Edit  button to modify an existing layout. The Default Layout For PSR palette 
opens. Modify the required fields.  

5. In the Format frame:  
a. Select properties from the Hidden Fields column and move them to the Displayed Fields 

column using the right arrow. You can also place them in the required ascending or 
descending order using arrows. 

b. Click Save to save the changes or Close to close the palette. 
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6. In the Properties frame: 
a. Enter a name in the Name field. 
b. Select the type of Access.   
c. Select the Paper Size from the list. 
d. Select the Orientation of the paper. 
e. Select the Layout Type. 
f. Select the View in format of the report. 
g. Click Save to save the changes or Close to close the palette. 

7. Click the Create  button to create a new layout. The Layout Presentation palette opens.  

8. In the Format frame: 
a. Select properties from the Hidden Fields column and move them to the Displayed Fields 

column using the right arrow. You can also place them in the required ascending or 
descending order using arrows. 

b. Click Save to save the changes or Close to close the palette. 

9. In the Properties frame:  
a. Enter a name in the Name field. 
b. Select the type of Access. 
c. Select the Paper Size from the list. 
d. Select the Orientation of the paper. 
e. Select a Layout Type. 
f. Select the View in format for the report. 
g. Click Save to save the changes or Close to close the palette. 

10. Select a format for the generated report from the Output Format list. You can choose from a list 
of formats - PDF, WORD, EXCEL, HTML, STANDARD.  

11. Select the Save a copy of the report in the historical reports check box to save the generated report. 

Note  The Save a copy of the report in the historical reports check box does not appear if you 
choose the Standard output format.  

12. Click Next. 
13. The Select Date Range page appears.  

a. Click the calendar and select a From date.  
b. Click the calendar and select a To date to show the time covered. 

14. Click Next.  
15. The Select Additional Parameters page appears. In the Workflow and Status Change Criteria 

frame, 
a. Select a workflow from the Workflow Type list. 

b. Click the Search  palette to effect a change in the Status Changes to field. A change palette 
opens. Select an item and double-click to move it to the Status Changes to field. 

c. Click Finish to display the report. 

16. A Get Attachment dialog prompts you to download the report.  
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Click the buttons that appear at the top of the generated report to save, print, or export the report. 
The report is lost if you click the Close button without saving it. 

Save: Saves the report to the Historical Report tab. 

Print: Prints the generated report. 

Export: Exports the content of the report to a delimited text file (CSV) or a Microsoft Excel workbook. 
 

Quality Backlog Report 

The Quality Backlog Report lists incidents that are at a specified status but have not moved to the 
next status during a specified period. 

To run a Quality Backlog Report: 

1. In the navigation pane, go to Reports > Reports and Analytics > Standard Reports > Quality Reports > 
Quality Backlog Report.  

2. Click the Execute button.  

A Quality Backlog Report wizard opens. 

3. The Select Layout Configuration page appears. Select a Layout from the list. 

a. Click the Edit  button to modify an existing layout. The Default Layout dialog opens. 
Modify the required fields. 

b. Select properties from the Hidden Fields column and move them to the Displayed Fields 
column using the right arrow. You can also place them in the required ascending or 
descending order using arrows. 

c. Click Save to save the changes or Close to close the palette. 

4. In the Properties frame: 
a. Enter a name in the Name field. 
b. Select the type of Access.   
c. Select the Paper Size from the list. 
d. Select the Orientation of the paper. 
e. Select a Layout Type. 
f. Select a View in format for the report.  
g. Click Save to save the changes or Close to close the palette. 

5. Click the Create  button to create a new layout. The Layout Presentation palette opens. In 
the Format frame,  
a. Select properties from the Hidden Fields column and move them to the Displayed Fields 

column using the right arrow. You can also place them in the required ascending or 
descending order using arrows. 

b. Click Save to save the changes or Close to close the palette. 

6. In the Properties frame: 
a. Enter a name in the Name field. 
b. Select the type of Access.  
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c. Select the Paper Size from the list. 
d. Select the Orientation of the paper. 
e. Select a Layout Type. 
f. Select a View in format for the report.  
g. Click Save to save the changes or Close to close the palette. 

7. Select a format for the generated report from the Output Format list. You can choose from a list 
of formats - PDF, WORD, EXCEL, HTML, STANDARD.  

8. Select the Save a copy of the report in the historical reports check box to save the generated report.  

Note  The Save a copy of the report in the historical report check box does not appear if you 
select the Standard output format. 

9. Click Next.  
10. The Select or Create a Query frame appears. The Quality Backlog Report lets you search for 

Product Service Requests to use in the report.  
a. Select the All Product Service Requests check box to choose from all the PSRs. 
b. Select the Saved Search check box.  

c. Click the Search  palette and choose a value from the saved Searches list.  
d. Select the Advanced Search check box.  
e. Click Define Query. A Report Search palette opens.  
f. Choose from the list or enter the necessary details to define the query. 
g. Click Clear to clear the selection, Finish to continue and Close to close the palette. 

11. Click Next to proceed to the next step or Back to modify the Query. 

The Define Report frame appears.  

12. In the Time Period frame: 
a. Use the calendar to select From date. 
b. Use the calendar to select To date. 
c. Choose a Time Unit from the list.  

13. In the Status Change frame: 
a. Select a workflow from the Workflow list.  
b. Select a Starting Status. 
c. Select a To status.  

14. In the Additional Report Criteria frame: 
a. Select a value from the Trend By list. 
b. Select the check box to display the Product Service Requests. 
c. Select the check box to Exclude Empty Columns. 

15. Click Finish to display the report. 
16. A Get Attachment dialog prompts you to download the report. 

Click the buttons that appear at the top of the generated report to save, print, or export the report. 
The report is lost if you click the Close button without saving it. 
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Save: Saves the report to the Historical Report tab. 

Print: Prints the generated report. 

Export: Exports the content of the report to a delimited text file (CSV) or a Microsoft Excel workbook. 
 

Quality Cycle Time Report 

The Quality Cycle Time Report calculates the time it takes for the specified product service requests 
and quality change requests (PSRs and QCRs) to move to another status in a specified period. 

The report lists the requests and shows the average time each PSR or QCR takes between two 
statuses. For example, the report indicates the average time it took for a PSR or QCR to go from 
Submitted to Released each month during the last year, grouped by a product line. 

To run a Quality Cycle Time Report: 

1. In the navigation pane, go to Reports > Reports and Analytics > Standard Reports > Quality Reports > 
Quality Cycle Time Report.  

2. Click Execute.  

A Quality Cycle Time Report wizard displays. 

3. The Select Layout and Configuration frame appears. Select a Layout from the list. 

4. Click the Edit  button to modify an existing layout. The Default Layout dialog opens. 
Modify the required fields. 
a. Select properties from the Hidden Fields column and move them to the Displayed Fields 

column using the right arrow. You can also place them in the required ascending or 
descending order using arrows. 

b. Click Save to save the changes or Close to close the palette. 

5. In the Properties frame: 
a. Enter a name in the Name field. 
b. Select the type of Access.   
c. Select the Paper Size from the list. 
d. Select the Orientation of the paper. 
e. Select a Layout Type. 
f. Select a View in format for the report.  
g. Click Save to save the changes or Close to close the palette. 

6. Alternately, click the Create  button to create a new layout. The Layout Presentation palette 
opens. In the Format frame: 
a. Select properties from the Hidden Properties column and move them to the Displayed 

Properties column using the right arrow. You can also position them in the required 
ascending or descending order using the arrow. 

b. Click Save. 

7. In the Properties frame: 
a. Enter a name in the Name field. 
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b. Select the type of Access. 
c. Select the Paper Size from the list. 
d. Select the Orientation of the paper. 
e. Select a Layout Type. 
f. Select a View in format for the report. 
g. Click Save to save the changes and Close to close the palette. 

8. Select a format for the generated report from the Output Format list. You can choose from a list 
of formats - PDF, WORD, EXCEL, HTML, STANDARD.  

9. Select the Save a copy of the report in the historical reports check box to save the generated report. 

Note  The Save a copy of the report in the historical reports check box does not appear if you 
select the Standard Output Format. 

10. Click Next. 
11. The Select or Create a Query page appears. The Quality Cycle Time Report lets you search for 

Product Service Requests to use in the report. 
a. Select the All Product Service Requests check box to choose from all the PSRs. 
b. Select the Saved Search check box. 

c. Click the Search  palette and choose a value from the Saved Searches list. 
d. Select the Advanced Search check box.  
e. Click Define Query. A Report Search palette opens.  
f. Choose from the list or enter the necessary details to define the query. 
g. Click Clear to clear the selection, Finish to continue and Close to close the palette. 

12. Click Next to proceed to the next step or Back to modify the Query. 

The Select or create a Query page appears.  

13. In the Time Period frame: 
a. Use the calendar to select From date. 
b. Use the calendar to select To date. 
c. Choose a Time Unit from the list.  

14. In the Status Change frame: 
a. Select a workflow from the Workflow list. 
b. Select a Starting Status. 
c. Select a To Status 

15. In the Additional Report Criteria frame: 
a. Select a value from the Trend By list. 
b. Select the check box to display the Product Service Requests. 
c. Select the check box to Exclude Empty Columns. 

16. Click Finish to display the report. 

17. A Get Attachment dialog prompts you to download the report. 

Click the buttons that appear at the top of the generated report to save, print or export the report. 
The report is lost if you click the Close button without saving it. 
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Save: Saves the report to the Historical Report tab. 

Print: Prints the generated report. 

Export: Exports the content of the report to a delimited text file (CSV) or a Microsoft Excel workbook. 
 

Quality Metrics Report 

The Quality Metrics Report shows quality incidents (product service requests and quality change 
requests) that moved to a specified status during a specified period. 

To run a Quality Metrics Report: 

1. In the navigation pane, go to Reports > Reports and Analytics > Standard Reports > Quality Reports > 
Quality Metrics Report. 

2. Click Execute.  

The Quality Metrics Report wizard displays. 

3. The Select Layout and Configuration page appears. Select a Layout from the list. 

4. Click the Edit  button to modify an existing layout. The Default Layout dialog opens. 
Modify the required fields. 
a. Select properties from the Hidden Fields column and move them to the Displayed Fields 

column using the right arrow. You can also place them in the required ascending or 
descending order using arrows. 

b. Click Save to save the changes or Close to close the palette. 

5. In the Properties frame: 
a. Enter a name in the Name field. 
b. Select the type of Access.   
c. Select the Paper Size from the list. 
d. Select the Orientation of the paper. 
e. Select a Layout Type. 
f. Select a View in format for the report.  
g. Click Save to save the changes or Close to close the palette. 

6. Alternately, click the Create  button to create a new layout. The Layout Presentation palette 
opens. In the Format frame: 
a. Select properties from the Hidden Properties column and move them to the Displayed 

Properties column using the right arrow. You can also position them in the required 
ascending or descending order using the arrow. 

b. Click Save to save the changes and Close to close the palette. 

7. In the Properties frame: 
a. Enter a name in the Name field. 
b. Select the type of Access.   
c. Select the Paper Size from the list. 
d. Select the Orientation of the paper. 
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e. Select a Layout Type. 
f. Select a View in format for the report. 
g. Click Save to save the changes and Close to close the palette. 

8. Select a format for the generated report from the Output Format list. You can choose from a list 
of formats - PDF, WORD, EXCEL, HTML, STANDARD. 

9. Select the Save a copy of the report in the historical reports check box to save the generated report. 

Note  The Save a copy of the report in the historical reports check box does not appear if you 
select the Standard output format 

10. Click Next.  
The Select or Create a Query page appears. The Quality Metrics Report lets you search for 
Product Service Requests to use in the report. 

11. Select the All Product Service Requests check box to choose from all the PSRs. 

12. Select the Saved Search check box. 

13. Click the Search  palette and choose a value from the list of Saved Searches. 

14. Select the Advanced Search check box.  
a. Click Define Query. A Report Search palette opens.  
b. Choose from the list or enter the necessary details to define the query. 
c. Click Clear to clear the selection, Finish to continue and Close to close the palette. 

15. Click Next to proceed to the next step or Back to edit the Query. 

The Define Reports page appears.  

16. In the Time Period frame: 
a. Use the calendar to select From date. 
b. Use the calendar to select To date. 
c. Choose a Time Unit from the list.  

17. In the Status Change frame: 
a. Select a workflow from the Workflow list. 
b. Select a status from the Status Type. 

18. In the Additional Report Criteria frame: 
a. Select a value from the Trend By list. 
b. Select the check box to display the Product Service Requests. 
c. Select the check box to Exclude Empty Columns. 

19. Click Finish to display the report. 

20. A Get Attachment dialog prompts you to download the report.  

Click the buttons that appear at the top of the generated report to save, print, or export the report. 
The report is lost if you click the Close button without saving it. 

Save: Saves the report to the Historical Report tab. 

Print: Prints the generated report. 
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Export: Exports the content of the report to a delimited text file (CSV) or a Microsoft Excel workbook. 
 

Quality Tracking Tabs 

You can link Quality information on certain tabs and fields with information about objects such as 
items, customers, and suppliers. The organization can then assess the quality risk of incorporating 
certain parts into their designs. 

 The Quality tab for items displays all PSRs reported against that item. 
 The PSRs tab of a Customer object lists all quality incidents reported by the customer. 

This can help you gauge customer satisfaction. 
 The PSRs tab of a Supplier object lists all quality incidents filed against the supplier. This 

can affect purchasing by helping you gauge the quality performance of a supplier so that 
you can establish a rating or preference for that supplier. 

 

Viewing Quality Issues against Customers and Suppliers 

Listed below are a number of ways you can view Quality issues against Customers or Suppliers. 

 Execute a Quick Search - Fastest way to find PSRs, QCRs, Customers, and Suppliers on the 
Home Page. 

 Custom Search - A combination of different queries returns PSRs with matching criteria. For 
example, Product Service Requests: Customer is not Null OR Supplier is not Null. 

 Advanced Search - Most effective way of finding objects setting multiple criteria and filtering down 
on objects. For example,  
Items with PSRs of Customer/Suppliers, which have QCRs initiated. 
Items only have PSRS for Customers/Suppliers but QCR is not initiated. 
Items having PSRs & QCRs and Changes associated with them.  

 y tab of Parts displays the PSR & QCR numbers along with Customer 

 
menu. For example, View all the QCRs/PSRs for Customers and Suppliers in displayed fields. 

 

View Parts - The Qualit
and Supplier details  

Search Personalization - Format a search and choose the required View by using the Personalize 
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Chapter 2 

Working with Product Service Requests 
You can create Product Service Requests (PSR), depending on the quality of the incidents. They can 
report either a single quality incident or multiple incidents with a single PSR.  

This chapter includes the following topics: 

 Creating Product Service Requests on page 19 

 Cover Page tab of a PSR on page 24 

 Affected Items tab of a PSR on page 28 

 Related PSR tab on page 33  

 Relationships tab on page  38

 Workflow tab of a PSR on page 49 

 Attachments tab of a PSR on page 50 

 Submitting and Routing PSRs on page 50 

ate PSRs. For more details on Roles and Privileges, 
see the Getting Started with Agile PLM guide.

Note  lity Analyst allows you to create, edit, delete, and perform all necessary 

 

Creating PSRs 
You must have the necessary privileges to cre

The role of a Qua
actions on PSRs. 

 

Creating a Product Service Request 

You can use the Create New feature to create a PSR.   

w > Product Service Requests > Problem Reports.  
3. 

b. default number, enter a number, or click the Autonumber 

To create a PSR in Java Client: 

1. Launch the Agile Java Client. 

2. On the main toolbar, click File > Ne
In the New dialog that appears,  
a. Choose the required sub-class (NCR or Problem Report) from the Type list. 

In the Number field, accept the  

e a Quality Analyst from the list.  

OK

Agile Java Client creates a PSR and displays it with the Cover Page in the edit mode.  

button to generate a number. 
c. Choos

4. Click .  
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For more information about the cover page, see Cover Page tab of a PSR  

 To create a PSR in Agile Web Client: 

1. Launch the Agile Web Client.  

2. On the main toolbar, click the Create New menu.  

3. Select Product Service Requests> Problem Report or Non-Conformance Report from the drop-down 
menu. The Create New dialog appears. 

4. Select a required subclass (NCR or Problem Report) from the Type list.  

5. In the PSR Number field, accept the default number, enter a number, or click the Autonumber 

 button to generate number. 

6. Click Save. 

The Agile Web Client creates the PSR and displays it with the Cover Page in the edit mode. 

 If you do not assign a workflow to the PSR, it displays the Unassigned status.  

To assign a workflow to the PSR: 

1. Open a PSR and click the Edit button.  

2. Select a workflow from the Workflow list. For details, see Workflow tab of a PSR.  

3. Click Save.  

The status of the saved PSR appears on the right corner of the page. For example, the status 
assigned can be - Pending, Submitted, Review, or Released. 

Creating a PSR from an Item 

You can create PSRs from an Item provided you hold the necessary privileges.  

To create a PSR from an Item in Java Client: 

1. Open an Item from which you want to create a PSR. 

2. Select Create New Product Service Requests from the Actions menu. 

3. In the New dialog: 
a. Choose the desired subclass (NCR or Problem Report) from the Type list. 
b. In the PSR Number field, accept the default number, enter a number, or click the Autonumber 

 button to generate a number. 
c. Choose a Quality Analyst from the list.  
d. Click OK.  

Agile Java Client creates the PSR and displays it with the Cover Page tab on top in the edit mode.  

4. Enter values in relevant fields on the Cover Page tab.  

5. Click Save to save the changes. 

The Item appears on the Affected Items tab of the new PSR. 
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To create a PSR from an Item in Web Client: 

1. Open the Item from which you want to create a PSR. 

2. On the Item page, choose Actions > Create New > Product Service Request. The Create New page 
appears. 

3. Choose the desired subclass, (NCR or Problem Report) from the Type list.  

4. In the PSR Number field, accept the default number, enter a number, or click the Autonumber 

 button to generate a number. 

5. The PSR opens in the edit mode. Click Save to save the changes. 

6. The PSR displays the Cover Page. The Item appears on the Affected Items table of the PSR.  

Agile Web Client creates a PSR and displays it with the Cover Page tab on top. The Item appears on 
the Affected Items tab of the new PSR. 

Creating a PSR to Aggregate multiple PSRs 

Consider the fact that you are a Quality Analyst in a firm. You notice several incoming shipments 
from suppliers that do not conform to the material specifications. You track down these incidents 
and create a single PSR to aggregate all the supplier's incidents. 

The single PSR you create is the Parent PSR. All the added PSRs on the Related PSR tab are child 
PSRs. 

Note  Depending on enabling/disabling the "PSR contains Items and Related PSRs" SmartRule 
setting, you can enable/disable the Affected Items tab after you add Related PSRs.  

To create a PSR to aggregate multiple PSRs in Java Client:  

1. Open a PSR you want to use as the basis for a new PSR or choose File > Save As or right click 
and choose Save As to. See, Creating PSR using Save As on page 22. 

2. The PSR opens with the Cover Page in the edit mode. On the Affected Items tab, do not add any 
items. On the Related PSR tab, add related PSRs.  

3. Click Add to add related PSRs.  

After you add related PSRs to this Parent PSR, the Aggregate PSR Number column for each child 
PSR on the Related PSR tab displays the number of the parent PSR. 

To create a PSR to aggregate multiple PSRs in Web Client: 

1. Open a PSR you want to use as the basis for a new PSR or choose Actions > Save As. The Save 
As page appears. 

2. The PSR opens with the Cover Page in the edit mode. On the Affected Items tab, do not add any 
items. On the Related PSR tab, add related PSRs.  

3. Click Add to add related PSRs. 

a. Click the Search to add  button to launch a palette. (Alternately, press the Ctrl +L key 
combination). 
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b. Click the Create to add  button to create new PSRs to add to the PSR. 

After you add related PSRs to this Parent PSR, the Aggregate PSR Number column for each PSR on 
the Related PSR tab displays the number of the parent PSR. On the Cover Page of the child PSRs, the 
Parent PSR number appears in Aggregate PSR Number field, automatically. 

Field  Completes  Ind icates 

PSR Event Manually Status of the Parent PSR that triggers an automated 
workflow event. 

Select an available status from the list. You can specify the 
status when the PSR has a workflow assigned. When this 
event occurs, it means that this PSR has reached the 
specified status.  

Note: Only if you assign a workflow to both objects (parent 
and child) on the Cover Page, can you specify the PSR 
Event status.  

PSR Result Manually The status to which you promote the related PSRs to, when it 
reaches the Event status. 

When the Parent PSR reaches the specified status in the 
PSR event field, the status of the Related PSR moves to the 
specified result in this field.  

Note: Only if you assign a workflow to both objects  (parent 
and child) on the Cover Page, can you specify the PSR 
Event status.  

 
 

Creating a PSR using Save As 

The Save As feature provides an easy method to create a PSR similar to the existing PSR. The Save 
As feature copies data from a field in the existing PSR to the same field of the new PSR. If a field or 
a list value in the existing PSR is not available in the new PSR, then the system does not copy the 
field or data to the new PSR. 

To create a PSR using Save As in Java Client: 

1. Open a PSR you want to use as the basis for a new PSR. 

2. Choose File >Save As or right -click and select Save As. The Save As dialog appears. 
a. Select the required sub-class (NCR or Problem Report) from the Type list. 
b. In the PSR Number field, accept the default number, enter a number, or click the Autonumber 

 button to generate a number. 
c. Click OK. 

Agile Java Client creates a PSR and displays it with the Cover Page in the edit mode. 

3. Enter values in relevant fields on the Cover Page tab. 

4. Click Save to save the changes. 
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 To create a PSR using Save As in Web Client: 

1. Open a PSR you want to use as the basis for a new PSR. 

2. Choose Actions >Save As. The Save As dialog appears. 

3. Select the required sub-class (NCR or Problem Report) from the Type list. 

4. In the PSR Number field, accept the default number, enter a number, or click the Autonumber 

 button to generate a number. 

5. If the original PSR contains Attachments, then a frame displays the following options: 
 Reference existing files — creates a new reference to the existing file folder on the new 

PSR's Attachments tab. 
 Create new copies of files — creates a new copy of the attachment, and places it in a 

newly created file folder. 
 Do not include files — creates a new PSR without any attachments. 

6. Click Save. The new PSR opens displaying the Cover Page in the edit mode. 

7. Enter values in relevant fields on the Cover Page tab.  

8. Click Save to save the changes. 

Caution In general, do not use the Save As feature to create an object in a different class or 
subclass of the original. The different classes or subclasses may not have the same 
tabs or defined fields, and access to data in the newly created object may be lost. 

 

Fie lds  copied  f rom o ld ob ject  Pre-populated  f ie lds  

Category, PSR Type, Problem Description, Severity, 
Product Line(s) 

Originator 

Page two and Page Three flex fields Date Originated 

Copies all the item information from the Affected Item tab. Status field is set to Unassigned by default. 

Copies all attachments from the Attachments tab  

History tab reflects the source and target objects  

The new PSR copies fields in the optional Page Two and Page Three sections, only if the Agile PLM 
Administrator has set appropriate preferences. Since Page Three data applies to a specific subclass 
only, if you use Save As to create a new object of a different subclass, the Page Three data is NOT 
copied to the new object. For more information about the behavior of Page Two and Page Three fields 
in an Agile PLM system, see the Agile PLM Administrator guide. 

The PSRs you create remain in the system until you delete them. Deleting PSRs does not remove 
them from the Agile database. To delete PSRs permanently, you need to hard-delete them. For 
details on deleting PSRs and QCRs, see Deleting Agile Objects on page 73. 
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Search for PSRs or QCRs 

Agil rch, and Advanced Search.   

h (Ctrl+ Shift +Q) button helps you locate objects by customizing the search 
esults display objects matching criteria. 

te specific objects by providing multiple search 

To ru

1. an 

The Search results return a list of objects. 

d Search option, if required.  

e PLM helps you locate objects by Quick Search, Custom Sea

 The Execute a Quick Search button helps you locate objects in the fastest possible way. 

 The Custom Searc
criteria. Search R

 The Advanced Search button helps you loca
criteria.  

n a quick search: 

Select object and enter a wildcard (*). 

2. Click the Execute a Quick Search button. 

Note  Select the Convert to Advance

For details, see 'Searches' in the Getting Started with Agile PLM guide. 

Cover Page tab of a PSR 
The followi  table lists an n t s 
information on work

ng d describes the fields o
ing with the tabs for 

he Cover Page tab of a PSR and provide
Product Service Requests. 

Fields  Completed  Ind icates 

PSR Number
Note: In the Admin setting if 

the number will be generated 
herwise you have 

R number. 

u The number assigned to the PSR when yo
create it. 

Automatically, when you create it. 

'Autogenerate' is set to 'Yes' then 

automatically, ot
to enter PS

For a Problem Report, the number is pre-
fixed with PR. 

For a Non-Conformance Report , it is pre-
fixed with a NCR.   

PSR Type Automatically, when you create it. elected when you The Type (subclass) s
create the PSR. 

Category Manually. s defined by the Agile 
r example:  

The list of categorie
PLM Administrator. Fo

Customer Complaint 

Audit - External 

Preventive Action 

Description nually, can contain a 
default. 

ile 
dministrator; up to 4000 bytes, 

Usually ma Maximum number of bytes is set by the Ag
PLM A
including spaces and carriage returns (which 
count as two bytes). 
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Customer Manually The list of customers associated with this 
PSR. 

Supplier Manually List of suppliers who initiated the incident or
are the cause of the 

 
incident. 

Severity Manually The list of severities defined by the Agile 
PLM Administrator. 

Disposition Manually ispositions defined by the Agile 

e that 
being 

resolved.  

 Replace 

The list of d
PLM Administrator. 

The Disposition field displays a cod
represents the way in which a PSR is 

Examples of dispositions are
Component and Rework to Spec. 

Expected  
Resolution Date

Manually Date when the PSR will be resolved. 

Quality Analyst May be provided automatically by 
the workflow; otherwise selected 
manually from a list. Departments 
appear first in the list, followed by 
individual user names.  

 the workflow to notify the default 

o every quality analyst 

s and 

If the notification definition in the workflow is 
blank, then no notifications are sent. 

The default Quality Analyst. 

If you define
Quality Analyst, the department or user in 
this field receives notifications about the 
PSR. If this field is blank, then the 
notifications are sent t
on the list.  

If the workflow is at the Pending statu
has a Quality Analyst defined than that User 
receives notification. 

Workflow plies 
is 

e workflow 

us. 

the 
next status from the Unassigned 
state  without assigning a 

The name of the workflow used to move this 
PSR through the quality tracking process. 

If more than one workflow ap
to the PSR, the workflow 
selected manually; th
selection can be changed as long 
as the PSR is in the Pending 
status. Selecting a workflow 
switches the PSR to the 
Unassigned stat

You cannot move the PSR to 

workflow. 

Status Automatically, when created ou 
atus remains 

Unassigned. 

The current workflow state of the PSR. If y
do not select a workflow, the st

Originator Automatically, when created. The default creator of the PSR. Also co
a list of other problem report origin

ntains 
ators.  
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Date Originated Usually automatically, when 
created. 

The date you create the PSR. 

Date Submitted Automatically generated based on 
workflow status.  

The date when the PSR moves to the 
Submitted status in the workflow. 

Date Released Automatically generated based o
workflow status.  

n 
Released status in the workflow. 
The date when the PSR moves to the 

Final Complete  atically generated based on 
tatus. 

The date when the PSR moves to the 
Date 

Autom
workflow s Complete status in the workflow. 

Aggregate PSR 
Number

Automatically filled in when you 
add PSR(s) to the Related PSR 

Automatically fills the parent PSR number. 

tab. 

Product Line(s) Manually The product lines this PSR affects. 

 
 

Updating the Cover Page of a PSR 

After you create a PSR, you can modify it to provide additional information you did not include when 
ded you hold the 

, 
 

lient: 

 PSR type fields are pre-populated. 

 Category field.  

bject dialog appears. 

6. 

7. ing 

8. 

Alte
ed Search option. 

quired. 
ick Save to save the changes, click More for additional criteria 

and click Clos  to close the dialog. 
over Page. 

he list. 

11. Use the calendar 

you created it or edit any information that has changed since its creation, provi
Cover page several times. Some of the fieldsappropriate privileges. You can modify the fields on the 

like the PSR Type, on the Cover Page are automatically populated.

To edit the Cover Page of a PSR in Java c

1. Open a PSR. The PSR number and the

2. Select a value from the list in the

3. Enter text in the Description field. 

4. Click the link to search for Customers. 

5. A Select O

Enter * and click the Search button. 

From the Search results list, select an object and move it to the Selected Objects column us
the arrow. 

Click OK. 

rnately, click the Advanced Search link. 
a. In the Advanced Search dialog, select the Create New or Use a Sav
b. Choose from lists or enter text as re
c. Click Run to run the search, Cl

e
d. Click OK to save the changes or Cancel to return to the C

9. Choose Severity of the PSR from t

10. Choose a Disposition from the list. 

 and select an Expected Resolution Date. 
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12. Click Save to save the changes. 

The Cover Page displays modified values. 

To edit the Cover Page of a PSR in Web Client: 

1. Open a PSR and click the Edit button to modify it. 

ber fields are automatically populated. 

4. 

5. To s you can either: 

2. The PSR number and PSR Type num

3. Select a value from the list in the Category field. 

Enter text in the D scription field. 

earch for Customers and Suppliers, 

e

 Click the  button below the Customer/Supplier field to launch a palette to search for 
existing Customers or Suppliers. 

 Click the  button to create new Customers or Suppliers. 

To s
The Search palette filters, searches, or browses for data from the database. 

earch for existing customers or Suppliers:

a. Click the  button below the Customer/Supplier field to launch a palett earch fore to s  
existing Customers or Suppliers. (Alternately, press the Ctrl +L key combination). 

b. r * to search for and click the Execute a Quick Search Enter a known value o  button. 
c. er from the list that appears. To move the Customer or Supplier  to 

ither  
D

 P

Note  

Select a Customer or Suppli
the Cover Page field, e
 rag and drop it. 
 Double-click on it. 

ress Enter. 

You can Search and add objects from a palette in three ways: 
Drag the selected object and drop it on the table of the required object. 
Double- he selected object. 

e the Getting Started with Agile PLM guide. 

click t
Select the object and hit the Enter key. 
For details, se

d. Click the Close  button to close the palette.  

 To create new customers:

e. Click the  button to create new Customers or Suppliers. 
f. In the Type field, select a Customer from the list.  

click the Autonumber g. In the Number field, enter a number or  button. 
h. Enter Customer Name. 
i. Click Save.  

6. Choose Severity of the PSR from the list. 

7. Choose a Disposition from the list. 
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8. Use the calendar  to select a resolution date. Alternately, click Ctrl+L to launch the palette. 

yst fields are pre-defined. 

9. Choose a Workflow from the list. Updates of the workflow status are automatic as the PSR 
moves to the next status. 

10. The Originator and Quality Anal

11. Click the  palette and choose one or more Product Lines that this PSR affects. (Alternately, 
press the Ctrl+L key combination). 

s tab of a PSR 

multiple items (like Parts, Documents). When you add PSRs to the Relationships tab, a PSR Items 

is not in the Released status of the workflow. 

12. Click Save to save changes.  

The Cover Page displays modified values. 

Affected Item
The Affected Items tab of a PSR lists items affected by the current PSR. A single PSR can affect 

table also appears.  

Note  You can add Affected Items only if the PSR 

You can add additional items (like parts, documents, assemblies) that need resolution to the 
PSRAffected Items tab. The same applies to QCRs also. You can modify the newly created  with 

A few fi  the Affected Item R are different from that of a PR. The table below lists 
lds in an NC dd deviations of a product. 

he Affected Items table lists and describes the following fields by default. 

any information that has changed since its creation. 

elds on s tab of an NC
additional fie R. These fields provide a itional information about 

T

Field  Completed   Ind icates 

Item Number Automatically, when created. Number of the Affected Item. 
 

Item Description Automatically, when created. Description of the item. 

Rev Found Manually h you 

 found displays B. 

vision 

The revision of the affected Item in whic
find the problem of the Affected Item. For 
example, if the item has undergone five 
revisions, and you identify the defect in 
revision B, then Rev
In Web Client, when you select an item to 
add, all the revisions of the item appear in the 
drop-down list with the latest released re
shown by default.  

Note: You can add multiple copies of an item 
at the same revision to the Affected Items tab.  
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Affected Site Automatically, when created. The site at which the affected items are 
having problems. 

Failure Mode Manually 

the Agile 

 each subclass of an item.  

 

Displays the reason a product failed or did not 
meet customer requirements. Select the 
failure mode from a list defined by 
Administrator. You can define a list of failure 
modes for

For example, a failure mode for a battery 
might be No Charge, and the failure mode of a
power strip might be Blown Fuse. 

Quantity affected r of Items affected by the quality 
incident. 

Manually The numbe

Rev Fix Automatically. When you fix 
the problem in the revision. 

The revision of the Item in which the problem 
is fixed. You can update this f

ed

change it 
ield manually or 

it is populated automatically when you release You can also 
manually. the ECO.  

Note  The Item Number field indicates the  Ascending or  Descending order of the table, 
depending on the sort order you choose in the Personalize menu. 

Note  The Personalize menu enables you to create and customize Views.  Use the Personalize 
u menu to create and save several views by defining filter conditions, and sort orders. Yo

can later choose the required view from the list of available views. 
 

Attributes of the Affected Items tab of an NCR 

The attri nd operation r to those of th ports except for a few 
addition  on the Affec . These fields provide information about 

ne or more .  

The table bel s the ss in whi s 
ls from a . 

butes a
al fields

s of NCRs are simila
ted Items tab

e Problem Re
 additional 

deviations in o products

ow detail
incoming materia

 fields of a proce
 supplier

ch the quality assurance team examine

Field  Completed  Ind icates 

Conformance  
Specification

Manually Information about what the materials should be, 
according to engineering specifications. 

Serial/Lot Number Manually s of the batch 
(this is similar to the unique 
tch of goods). 

Serial number or Lot number of the item
that was defective 
identifier for the ba

Total Quantity  
Suspect

Manually y suspected of problems. 

e, you receive a lot of 500 units, inspect 
tive: 

Total Quantit

For exampl
20 units and find that 5 are defec

500 total suspect 

20 checked 
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5 affected 

Quantity Checked Manually The number of inspected items. 

Quantity Affected Manually The actual number of items affected with problems. 

Containment  Manually en to dispose the material. Containment actions tak
Actions

RMA Number Manually  the 
 supplier that authorizes you to send 

the defective materials back to the source; it is 
usually a slip of paper. 

Return Merchandise Authorization. This is
number from the

Conforming Material 
Date

Manually The date when the suppli
send materials that does 

er expects to be able to 
conform to the 

specifications.  

 
 

Adding Items to the Affect

To a

 and click the Affected Items tab. 

ed Items tab of a PSR 

You can add Items to a PSR using the Add button on the Affected Items table. You can either 
search for existing Items or create new Items. Items can in de Parts, BOMs. 

dd Items to the Affected items tab in Java Client: 

clu

1. Open the PSR

2. Click the Add  drop-down and choose the Create  button to create new items, the 

Search  button to search for one or more existing items, and Type-in-known numbers  to 
 known items. 

 To c

ype list. 

s

1.  Items dialog box. 

earch, run a Saved Search, select a Bookmarked item, or select from the Recently 
er. 

3. he selected item 

it rows after adding checkbox, to select different revisions of items or edit 

search for

reate Items:  

1. Select a type from the T
2. If appropriate, enter an Item number and a description. 

3. Click OK. 

The Item appears on the Affected Items table.  

 To earch for existing Items: 

Select a search method from the Add Affected
2. To perform a simple search, enter the value to search for and click Search. You can also define 

an Advanced S
Visited fold

Select the items from the search results. Use the right arrow or double-click t
to move it to the Select Related Items column. 

4. Ensure to select the Ed
other fields. 

5. Click OK. 
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The ite n the m i

To Type in Know

ck Add. 

 once without selecting an option from the list, the Type-in 

Selected Affected Items list appears on the Affected Items table. 

n Numbers: 

1.  Enter one or more numbers on separate rows, and cli

2. The Item appears on the Affected Items table.  

Note  If you click the Add button
Known Numbers dialog ap ars. pe

To add Ite

1. Ope

2. Clic

 Click e Search to add 

ms to the Affected Items tab  PSR in Web Client: of a

n the PSR and click the Affected Items tab.  

k Add in the Affected Items tab.  

th  button to launch the palette to search for existing items. 

e to add  Click the Creat  button to create new Items. 

an Item existing on one PSR and paste it in the Affected Item's table of another 

1. 

 Select an Item from the Recently Visited folder, drag and drop it in the Affected Items 
table.  

 Copy 
PSR.    

To search for existing items: 

Cl k the Search to add ic  button to launch the palette. (Alternately, press the Ctrl +L key 

2. Enter the value or * to search for and click the Execute a Quick Search 

combination). 

 button. 

 to the Affected Items table, you can either: 

-click on it. 
 

3. Select an Item from the list that appears. To move it
 Drag and drop it. 
 Double

Press Enter.  

4. Click the Close  button to close the dialog box.  

The Item Affected Items table.  appears on the 

To create items: 

1. Click the Create to add  button. 

2. 

ter a number or click the Autonumber 

In the Type field, select an Item from the list. 

3. In the Number field, en  button. 

r click Cancel to return to the Affected Items table. 

4. Enter details in the Description field. 

5. Click Add to add the item to the table o

The Item appears on the Affected Items table. 
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To c

1. Select an 
PSR tab, 

2. Click the M
3. Navigate to the Affected Items tab of another PSR. 

The Item appears on the Affected Items table. 

r PSRs determines whether you can 

opy and paste objects: 

Item from the Affected Item's table of a PSR. (The object can be from either the Related 
Relationships tab, or the Attachments tab of a PSR or from another object). 

ore button and select Copy. 

4. Click the More button and select Paste. 

Note  ny Items peAn Agile PLM SmartRule named Ma
add multiple items to the Affected Items tab of a PSR. If Many Items per PSR is set 

Item to the PSR. Otherwise, you can add only to Allow, you can add more than one 
one Item (one row) to the PSR. 

 

Removing an Item from the Affected Items tab 

To remove an Item from the Affected Items tab in Java Client: 

1. Open a PSR and click the Affected Items tab. 

2. Select the row of the Item you want to remove. 

3. Click the Remove  button. 

4. Click OK to confirm a message, which prompts you to confirm removal of the Item. 

Client: 

ow of the Item you want to remove. 

oved from the table. 

ey are not in the 

To ed

Items tab. 

2. 

3. Click the Edit Affected Items 

To remove an Item from the Affected Items tab in the Web 

1. Open a PSR and click the Affected Items tab. 

2. Select the r

3. Click Remove. 

A message bar displays the number of rows rem

Editing Items on the Affected Items tab 

You can edit items on the Affected Items tab several times if necessary, as long as th
Released state. 

it the Items on the Affected Items tab in the Java Client: 

1. Open a PSR and click the Affected 
Select the item row you want to edit. 

 button. The Edit Affected Items dialog appears. 

4. Doub

5. Modif s. 

le-click on the cell of the row you want to edit, to edit the required fields. 

y text or use the lists to select value

Alternately, double-click on the cell, modify the cell and press Enter 
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6. he

For 

W n you finish editing, click OK. 

more details on the fields see, the Affected Items tab of a PSR on page 28. 

 If you manually update the Rev Fixed field, then you automatically populate the Latest Note
Change field with the ECO related to that revision change. The Rev Fixed drop-down list 
contains all revisions for the item. 

For example, you can manually update the Rev Fixed field in the following cases: 

r revision. 
nt and that is not associated with a change or QCR. 

To edit the Items on the Affected Items tab in the Web Client:  

2. Selec

To edit the required fields, double-click on the cell of the row you want to edit. Alternatively, you 
d press Enter. 

o select values.  

d, then you automatically populate the Latest 

 You submit a quality incident, and you already release or implement a known fix; then you 
simply update the Rev Fixed field to account for the fact that this problem was already 
addressed and corrected in that particula

 Update a PSR that does not have a pare

1. Open a PSR, and click the Affected Items tab.  

t the row you want to edit.  

3. 
can navigate to the cell an

4. Enter text or use the lists t

5. Click Save to save the changes. 

Note  If you manually update the Rev Fixed fiel
Change field with the ECO related to that revision change. The Rev Fixed drop-down 
contains all revisions for the item. 

list 

 

Related PSR tab 
The Re R tab cont s that aggregate into a single Parent PSR. Edit information 

elated re

ple, if multiple customers reporte d creates a 
Problem Report. The  realizes le 
solution. To resolve the problem, the Qual
(Aggregates) the related PSRs to the Pare

The Related PSR tab lists and describes the following columns by default: 

lated PS ains a list of PSR
and aggregate r  PSRs into the Pa

Quality team

nt PSR. 

d similar problems, each problem reporteFor exam
 they are related and hence can be resolved with a sing

ity team creates a single PSR (Parent PSR) and adds 
nt PSR.  

Field  Completes  Ind icates 

PSR Criteria Met
(Image)

Automatically, when 
you meet the PSR 
Event criteria. 

Indicates when the PSR event occurred (that is, the parent PSR has 
reached the status selected for the PSR event). 

Once the parent PSR attains the status specified in the PSR Event 
field, then the related PSR status automatically moves to the status 
specified in the PSR Result field and completes the criteria specified. 
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Event Manually The status of the parent PSR that triggers an automated workflow 
event. 

Select an available status from the list. You can specify the status only 
when the PSR has a workflow assigned. When this event occurs, it 
means that the PSR has reached the specified status. 

The default value of the PSR Event is set to the Closed status. If you 
have Quality Analyst privileges, you can set the default value to 
another status in Java Client. For details, see the Relationships tab. 

Note: You can specify the PSR Event status only when both objects 
(parent and child) are assigned a workflow on the Cover Page tab. 

Result Manually The status to which the related PSRs are promoted when the event 
status is reached. Select an available status from the list. You can 
specify the status only when the PSR has a workflow assigned. 

When the parent PSR reaches the status in the PSR Event field, then 
the status of the related PSR is automatically moved to the specified 
result status in this field. 

The default value of the PSR Result is set to the Closed status. If you 
have Quality Analyst privileges, you can set the default value to 
another status in Java Client. For details, see Relationships tab. 

Note: You can specify the PSR Result status only when both objects 
(parent and child) are assigned a workflow on the Cover Page tab. 

PSR Type Automatically The type of the PSR 

PSR Number Manually; when you 
enter the PSR 
number 

The related PSR number. 

PSR Category Automatically The quality incident category of the related PSR. 

PSR Customer Automatically The customers associated with the related PSR.  

PSR Supplier Automatically The suppliers associated with the related PSR. 

PSR Severity Automatically The severity of the related PSR. The Agile PLM administrator defines 
the severities. 

PSR Disposition Automatically The way the PSR was resolved. 

PSR Expected 
Resolution Date

Automatically The date you expect the resolution for the related PSR.  

PSR Quality 
Analyst

Automatically The quality analyst assigned to the related PSR. 

If you define the workflow to notify the default quality analyst, the 
department user in this field receives notifications about the PSR 

PSR Workflow Automatically The name of the workflow used to move this PSR through the quality 
tracking process.  
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PSR Status Automatically The workflow status of the related PSR. If you do not select a 
workflow, this field is Unassigned.  

PSR Originator Automatically, when 
created 

The default creator of the PSR. 

PSR Date 
Originated

Usually 
automatically, when 
created 

The date when you create the related PSR. 

PSR Date 
Submitted

Usually 
automatically, when 
created 

The date when you submit the related PSR. 

PSR Date Released Usually 
automatically, when 
created 

The date when you release the related PSR. 

PSR Final Complete  
Date

Usually 
automatically, when 
created 

The date when you complete the related PSR 

Aggregate PSR  
Number

Automatically filled 
in when PSRs are 
added to the 
Related PSR tab. 

Field filled in automatically with the parent PSR number. 

Note  The Event field indicates the  Ascending or  Descending order of the table, 
depending on the sort order you choose in the Personalize menu. 

Note  The Personalize menu enables you to create and customize Views.  Use the personalize 
menu to create and save several views by defining filter conditions, and sort orders. You 
can later choose the required view from the list of available views. 

 

Adding Related PSRs to the Parent PSR 

To add Related PSRs to the Parent PSR in Java Client: 

1. Open a PSR and click the Related PSR tab. 

2. Click  and choose one of the following options. The Create  button allows you to create 

objects and the Search  button allows you to search for existing objects. 

To create objects:  

1. Select a type from the Type list. Enter an object number and a description. 

2. Click OK. 

The object appears on the Related PSRs table. 

To search for one or more existing objects: 

1. In the Add Related Objects dialog box, select a search method. 
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2. To perform a simple search, enter the value to search for and click Search. You can also define 
an Advanced Search, run a Saved Search, select a Bookmarked object, or select from the Recently 
Visited folder (Shortcut). 

3. Select the objects from the search results. Use the right arrow or double-click to move it to the 
Select Related Objects column. 

4. To select different revisions of objects or edit other fields, ensure to check the Edit rows after 
adding check box. 

5. Click OK. 
The object appears on the Related PSRs table. 

Note  If you click the Add icon without selecting the list, you see the Add Related PSR 
(Search) dialog box. 

To add Related PSRs to the Parent PSR in Web Client: 

1. Open a PSR and click the Related PSR tab. 

2. In the Related PSR table, click Add. 

 Click the Search to Add  button to launch a palette to search for existing PSRs. 

 Click the Create to Add  button to create new PSRs to add to the Related PSR tab. 
 Select a PSR from the Recently Visited folder, drag and drop it in the Related PSRs table. 
 Copy a PSR existing on one PSR and paste it in the Related PSR table of another PSR. 

To search for existing objects: 

1. Click the Search to Add  button to launch a palette to search for existing PSRs.  (Alternately, 
press the Ctrl +L key combination). 

2. Enter the value or * to search for and click the Execute a Quick Search  button. 

3. Select a PSR from the list that appears. To move it to the Related PSR table and either: 
 Drag and drop it. 
 Double-click on it. 
 Press Enter. 

4. Click the Close  button to close the dialog box. 

The object appears on the Related PSR table. 

 To create new objects: 

1. Click the Create to Add  button to create new PSRs. 

2. In the Type field, select an object from the list.  

3. In the Number field, enter a number or click the Autonumber  button. 

4. Enter details in the Description field. 
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5.  Cancel to return to the Related PSR table.  

Editing Items on the Related PSRs tab 

fy the information in the fields of the Related PSRs tab, provided you hold appropriate 

ou want to edit. 

Click Add to add the object to the table or click

The object appears on the Related PSR table. 

You can modi
privileges. 

To edit Related PSRs in Java Client: 

1. Open a PSR and click the Related PSR tab. 

2. On the Related PSR table, select the row y

3. Click the Edit  button to edit the row. 

t to select values and edit required fields.  

 you want to edit. 

3. -cl

Note  are not able to open a cell, a message bar displays that you cannot edit the 

4. Double-click the cell you want to edit. 

5. Use the lis

6. Click OK. 

To edit Related PSRs in Web Client: 

1. Open a PSR and click the Related PSR tab. 

2. On the Related PSR table, select the row

Double ick the cell you want to edit  

If you 
field. 

4. Use the list to select values and edit required fields. 

Note  

5. Click Save to save changes. 

The PSR Event drop-down list shows the available statuses of the Parent PSR. You can 
select the statuses of the parent and the related PSR, such that when the Parent PSR 
reaches the status in the PSR Event field, the related PSR moves to the status in the PSR 

Note  , 
losed status, the related (child) PSR moves 

automatically to the Closed status. 

Result field. 

For example, if you set the PSR Event field to Closed and the PSR Result field to Closed
once the Parent PSR reaches the C

 

Removing Related PSRs 

 tab. 

ove. 

3. 

To remove Related PSRs in Java Client:  

1. Open a PSR and click the Related PSR
2. Select the PSR yo ant to remu w

Click the Remove  button. 
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A dialog prompts you to remove the related PSR after confirmation. 

 tab. 

 you want to remove. 

3. 

e

Note  ent PSR does not appear in the Aggregate PSR Number field on the 

To remove Related PSRs in Web Client:  

1. Open a PSR and click the Related PSR
2. Select the PSR

Click Remove. 
A m ssage bar displays the number of rows removed from the table. 

The number of the Par
Cover Page of the PSR. 

 

Relationships tab 

 Relationships tab of both the objects. You 

 the 
sage bar. Specific objects display tables with 

you can perform. 

Relationships - Table 

sts for that class and its subclasses.  

nd subclasses. 

t support the functionality. 

ct. 

Life dicates t/result ss o n L of t.  

The Relationships tab allows you to create relationships between the current PSR or a QCR and other 
routable and lifecycle objects. The relationship is visible on
can specify a rule between the objects, which is optional. 

Relationships tab of Agile objects have the option to specify a rule between the objects. When you 
position the cursor on the PSR/QCR, it displays a Quick View info link. A click on the Quick View dialog 
provides substantive information without having to navigate to the object. The message bar displays 
the Add rule link and (if you specify a rule) displays it in the Web Client. Once you specify a rule,
Edit Rule and Remove Rule links appear on the mes
related views and actions that 
 

The Relationships table lists all the Agile objects. In the Relationships table: 

Exists - Indicates that the functionality exi

In the Relationship with a Rule column:  

Yes - Indicates you can add the functionality to its class a

No – Indicates that it does no

In the Event/Result column: 

Workflow - indicates the event /result for a class object, based on the workflow state of that obje

cycle - in the even  for a cla bject, based o ifecycle state  that objec

Agi le   
Base  
C lass  

Agi le   
C lasses 

Event /  
Resul t  

R ie lat ionsh
p   wi th  a

Rule  

References-  L i fecycl
e  under  
Change 

Relat ionshi
p  w o i th  n

ru le  Control  

Changes   Workflow Exists Exists NA Change
Orders 
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 Workflow Exists Exists NA Change 
Requests 

 Deviations Workflow Exists Exists NA 

 turers Workflow Exists Exists NA Manufac
Orders 

 Price ange Workflow Exists Exists NA Ch
Orders 

 Site nge Workflow Exists Exists NA Cha
Orders 

 Stop Ship Workflow Exists Exists NA 

Customers Customers Lifecycle Yes Exists No 

Declarations us Workflow Exists Exists NA Homogeneo
Material 
Declaration 

 IPC 

 

Workflow Exists Exists NA 1752-1 

Declarations

 IPC 
ns 

Workflow Exists Exists NA 1752-2 
Declaratio

 
rations 

Workflow Exists Exists NA JGP SSI 
Decla

 Part 
 

Workflow Exists Exists NA  
Declarations

 
ns 

Workflow Exists Exists NA Substance 
Declaratio

 

e 

Workflow Exists Exists NA Supplier 
Declaration of 
Conformanc

File Folders s File Folder Lifecycle Yes Exist No 

Items ents Docum Lifecycle Yes Yes NA 

 Parts Lifecycle Yes Yes NA 

Manufacturer acturer Lifecycle Yes Yes NA 
Parts

Manuf
Parts 

Manufacturer er o Manufactur Lifecycle Yes Yes N

Packages Packages Workflow Yes Yes  
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Part Groups Part Groups Lifecycle Yes Yes No 

Prices Published 
Process 

Lifecycle Yes Yes Yes 

 Quote  
Histories 

Lifecycle Yes Exists Yes 

PSRs Non 
Conformance 
Reports 

Workflow Exists Exists NA 

 Problem  
Reports 

Workflow Exists Exists NA 

Programs Activities Workflow Exists Exists NA 

 Gate Workflow Exists Exists NA 

QCRs Audit Workflow Exists Exists NA 

 CAPA Workflow Exists Exists NA 

Requests for 
Quotes

Requests for 
Quotes 

Lifecycle Yes Yes No 

RFQ 
Response

RFQ 
Response 

Lifecycle Yes Yes No 

Sites Sites Lifecycle Yes Yes No 

Sourcing 
Projects

Sourcing 
Projects 

Lifecycle Yes Yes No 

Specifications Specifications Lifecycle Yes Yes No 

Substances Materials Lifecycle Yes Yes No 

 Sub Parts Lifecycle Yes Yes No 

 Substances Lifecycle Yes Yes No 

Suppliers Suppliers Lifecycle Yes Yes No 

Transfer 
orders

Automated 
Transfer  
Orders 

Workflow Yes Yes NA 

 Content  
Transfer 
Orders 

Workflow Yes Yes NA 
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User Groups User Groups None No Yes NA 

Users Users Status 
Attribute 

No Yes NA 

Action Items Action Items Status 
Attribute 

No No NA 

Discussions Discussions None No Yes NA 

Reports Custom  
Reports 

None No No NA 

 External  
Reports 

None No No NA 

 Standard 
Reports 

None No No NA 

 
 

Relationships in PQM 

This is some additional information about relationships as they are used in the PQM solution: 

Important When relationships are created between PQM objects, a blank rule is created for the 
relationship. You must edit the blank rule to define how you want the PQM objects to 
affect each other. 

 When a QCR affects the PSR, that is, when a QCR and PSR are related and the relationship 
rule follows the format: 

When <QCR source object> is <event>, set <PSR target object> to <result>

all items from the PSR Affected Items tab are displayed on the PSR Items table of the QCR. If 
the PSR was used to aggregate multiple PSRs, then the related PSRs’ affected items are 
displayed. 

 When this QCR is affected by a PSR, that is, when the QCR and the PSR are related and the 
rule follows the format: 

When <PSR source object> is <event>, set <QCR target object> to <result>.

all items from the PSR Affected Items tab and the related PSR’s affected items are not displayed 
on the PSR Items table of the QCR. 

Attributes of a Relationship 

When you add an object to a project as a deliverable, you add the project on the relationship tab of 
that object as well. You can define a relationship rule between these two objects and view the rule 
from both objects. 

 When you add an object as a relationship to the second object, it creates a reverse relationship 
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and displays the second object under the Relationships tab of the first object. 

 There are no default relationship rules between two objects. 

 When you add a relationship to an object that has a revision: 
 The name field of parts or documents shows the object name or number only if the rule is 

pending. Click the object name or number. In the editable fields, enter text or use the lists. 
The revision displays the latest revision.  

 The object revision displays in the name field when the rule is met, (i.e. the lifecycle of the 
event has occurred). 

 For example, if the triggering event is when the lifecycle moves to Production, then you 
see the first revision of the production phase here. 

 The name field value is hyper-linked and links to the cover page for revision. 
 In Java Client, to add, edit or remove a rule, click the Add Rule, Edit Rule or Remove Rule 

 lays the rule. You can also use the edit and remove rule 

ps' chapter in the Getting Started with Agile PLM guide.

Relationships tab Tools 

e g buttons: 

conditions, and sort orders. You can later choose the required view from the 

button respectively. 
In Web Client, a message bar disp
links to edit and remove the rule. 

 Attachments related to folders display folder version when the set criteria is met. 

For details, see the 'Relationshi

Th  Relationships tab has the followin

 Add: Allows you to add objects. 

 Remove: Allows you to remove objects. 

 Edit Rule: Allows you to add a rule or edit the rule. 

 More: Contains more actions that you can perform. (copy, paste, fill-down, fill-up)  

The Relationships tab page includes the Views and Personalize buttons. The Personalize menu 
enables you to create and customize Views.  Use the personalize menu to create and save several 
views by defining filter 
list of available views. 

See also: Relationships Table on page 42

For details, see 'Navigating in the Agile Web Client' in the Getting Started with Agile PLM guide. 

The R s table lists  columns by default: 

Relationships Table 

elationship  the following

 F ie ld  Completed  Ind icates 

Criteria Met  
(image) hip rule of the objects 

added. 
, 

Automatically. When you meet 
relations

Indicates when the added object attains the 
specified status. Onc ou meet the criteria
you see the symbol 

e y
 in the Web Client 

and   in the Java Client.    
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Type (Image) bject you add. Automatically  The type (image) of the o

Name Automatically  The name of the object  

Description Automatically d with the The description of the object you ad
number. For example, (PR00054). 

Current Status y when you add The current status of the related object. Automaticall
the object.  

Rule cally when you add 
the rule  Rule only if you assign a 

Automati Displays the rule specified. 

Note: You can specify
workflow to the PSR. 

Type Automatically  ded object. (For example, 
) 

The type of the ad
Problem Report

The Name field indicates the  Ascending or  Descending order Note  of the table, 
depending on the sort order you choose in the Personalize menu. 

The Note  
ions, and sort orders. You 

can choose the required view from the list of available views. 

Personalize menu enables you to create customized Views.  Use the personalize 
menu to create and save several views by defining filter condit

 

Adding Objects to the Relationship tab of a PSR 

You can add any of the Agile objects to a Relationships table. The Administrator needs to set 
n Agile objects. 

ent: 

2. 

appropriate privileges to define Relationships betwee

To add objects to the Relationships table in Java Cli

1. Open a PSR and click the Relationships tab. 

Click the Add  button in  the Relationships table. The Create  button allows you to create 

nd the Search new objects a  button allows you to search for one or more existing objects. 

mber or click the Autonumber 

To create objects:  

1. Select a sub-class from the Type list. 

2. Enter a nu  button. 

3. 

e Relationships tab. 

2.  an 
ed Search, select a Bookmarked object, or select from the Recently 

3. 

Click OK. 

The object appears on th

To search for existing objects:  

1. In the Add Relationship dialog box, select a search method. 

To perform a simple search, enter value to search for and click Search. You can also define
Advanced Search, run a Sav
Visited folder (Shortcuts). 

Select the items from the Search Results. These can be PSRs, QCRs, or Changes. Use the 
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right arrow or double-click the selected object to move it to the Select Related Objects column. 

5. revisions of items or edit other fields, ensure to select the Edit rows after 
box. 

6. 

 table. 

 

ionships tab. 

2. 

4. The selected object appears in the Select Related Objects column. 

To select different 
adding check 

Click OK.   
The selected object appears on the Relationships

 To add objects to the Relationships tab in Web Client:

1. Open the PSR and click the Relat
Click the Add drop-dow nu. n me

 The Search to add  button allows you to search for existing objects. 

 The Create to add  button allows you to create new objects. 
 Select an object from the Recently Visited folder, drag and drop it in the Relationships table. 

ng on a PSR and paste it in the Relationships table of another PSR. 

1. 

 Copy an object existi

 To search for existing objects:  

The Search to add  button allows you to search for existing objects. (Alternately, press the 

for and click the Execute a Quick Search 

Ctrl +L key combination). You can search for PSRs, QCRs, Items, or s. Change

2. Enter the value or * to search  button. 

4. ionships table, you can either: 

5. 

3. Select an object from the list. 

To move it to the Relat
 Drag and drop it 
 Double-click on it. 
 Press Enter. 

Click the Close  button to close the dialog box. 

pears on the Relationships table. 

c

r click the Autonumber 

The object ap

 To reate objects: 

1. Select a sub-class from the Type list. 

2. In the Number field, enter a number o  button to generate a number. 

4. Cancel to return to the Relationships PSR table. 

ships table. 

You can edit the Relationships table to include additional information or modify existing information. 

3. Enter details in the Description field. 

Click Add to add the object to the table or click 

The object appears on the Relation

Editing the Relationships table 
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To edit the Relationships table in Java Client: 

1. Open a PSR and click the Relationships tab. 

2. Select the row you want to edit. 

3. Click the Edit Relationship  button. 

4. Modify required fields.  

5. Click OK. 

The modified values appear on the table. 

To edit the Relationships table in Web Client: 

1. Open a PSR and click the Relationships tab. 

2. Double-click the field you want to edit. 

3. Modify required fields. 

4. Click Save. 

The modified values appear on the table. 

Removing Relationships 

You can remove an object on the Relationships tab if found to be inappropriate. Removing a 
relationship from the Relationships tab of an object also removes it from the Relationships tab of the 
object to which it is related. 

To remove Relationship in Java Client: 

1. Open a PSR and click the Relationships tab. 

2. Select the object row you want to remove. 

3. Click the Remove Relationship  button. 

The object does not appear on the Relationships table. 

To remove Relationship in Web Client: 

1. Open a PSR and click the Relationships tab. 

2. Select the object row you want to remove. 

3. Click the Remove button. 

A message bar displays the number of rows that have been removed. The object does not appear 
on the Relationships table. 

Relationship Rules 

The Relationship rule specifies how the workflow you define for an object affects the workflow status 
of another object. For example, When PR0048 is Submitted, Set PR00049 to Review. 

 A lifecycle object can only be a source and not a target of a relationship. 
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A lifecycle object can only be a source and not a target of a relationship. When you add a 
relationship from a lifecycle object to a workflow object, the state of the lifecycle affects the 
state of the workflow object. 

For example, the relationship rule is defined between a Problem Service Request (workflow 
object) PR00061 and a (workflow object) Engineering Change Order. The rule says that, When 
PR00061 is Released, Set the Engineering Change Order to Released. Fix the positions of the 
“From Object” (PR00061) and the “To Object” (Engineering Change Order) in the rule so that 
the rule only affects workflow objects. 

When you add a relationship from a workflow object to a lifecycle object, the state of the 
lifecycle objects affects the state of the workflow object and not the reverse way. 

 When you add a relationship from a workflow object, you can define a relationship rule to another workflow 
object in both directions. 
For example, in a relationship between two workflow objects – QCR QCR12345 and PSR 
PR55768 the When drop-down will list two objects – QCR12345 and PR55768, the Set drop-
down will also have the same two objects. You cannot select the same object in both, When and 
Set. When you select an object from When list the Set field will be upgraded with another object.  

The relationship should be viewable from both the objects and the rule displayed must be the 
same. 

 You cannot define a relationship rule between two lifecycle objects. 

You can only define a relationship rule only between a lifecycle object and a workflow object 
and not between two lifecycle objects. 

Adding Relationship Rules 

The Relationships tab has the option to associate a rule between objects. Specific objects display 
tables with related views along with the actions that you can perform on the related object. 

For example, if you add Items to the Relationships tab, the table displays an Affected Items table with 
the Item Number and Item description fields. The number field is a hyper-link. 

To access more information about this object, click the Quick View info link. This appears when you 
position the cursor on the corresponding object and allows you to view details of the object and 
perform some actions without navigating to the actual object. 

The message bar in the Quick View dialog displays the Add Rule link, which allows you to specify a 
rule. Once you specify a rule, the Edit Rule and the Remove Rule links also appear. 

To add a Relationship rule in Java Client: 

1. Open a PSR and click the Relationships tab. 

2. Select the PSR row you want to add a rule in. 

3. Click the Add Rule  button. 

4. A Relationship Rule dialog opens. Specify a rule. 

For example: 

When PR0002 is Review
Set PR123304 to Submitted. 
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5. Click OK.  

The rule appears in the Relationship table of the corresponding object. 

To add a Relationship Rule in Web Client:  

1. Open a PSR and click the Relationships tab.  

2. On the Relationships table, you can either use the Edit Rule button to add a Rule or click the 
Quick View info link that appears when you position the cursor on the PSR. 

3. A dialog appears. A message bar displays the Add rule link or the rule (if specified). 

4. Click the Add Rule link. 

5. The Relationships Rule dialog opens. Specify a rule. 

For example, 

When Problem Report PR000142 is Review
Set Problem Report PR00144 to Submitted. 

6. Click Save. 

The rule appears on the message bar. 

7. Click the Close  button to close the palette. 

Alternately, you can use the Edit Rule button to add a rule. 

The rule appears in the Relationships table of the corresponding object. 

Editing Relationship Rules 

You can modify the rule of an object on the Relationships table. Use either the Edit Rule button on 
the Relationships table or the Edit Rule that appears in the Quick View dialog message bar. 

To edit the Relationship rule in the Java Client: 

1. Open a PSR and click the Relationships tab.  

2. Select a row on the Relationships table you want to edit. 

3. Click the Edit Rule  button. 

4.  In the Relationships Rule dialog, modify the rule.  

5. Click OK. 

The modified rule displays on the Relationships table. 

 To edit the Relationship rule in the Web Client: 

1. Open a PSR and click the Relationships tab. 

2. You can either: 

Click the Edit Rule button. 
 In the Relationships Rule dialog, modify the rule.  
 Click Save to save the changes.  
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 Click the Quick View info link that appears when you position the cursor on the PSR.  
 Click the Edit Rule link. 
 In the Relationships Rule dialog, modify the rule. 
 Click Save to save the changes. 

3. Click the Close  button to close the palette. 

The modified rule displays on the Relationships table. 

Removing Relationship Rules 

You can remove the rule associated with the relationship, if not applicable. In the Web Client, once 
you specify a rule, the message bar on the Relationship dialog displays the Remove Rule link. 

To remove the relationship rule in Java Client: 

1. Open a PSR and click the Relationships tab. 

2. Select the row on the Relationships table, which contains the rule. 

3. Click the Remove Rule  button. A dialog confirms removal of the rule. 

The rule does not appear in the Rule column. 

To remove the relationship rule in Web Client:  

1. Open a PSR and click the Relationships tab. 

2. Click the Quick View info link, which appears when you position the cursor on the PSR. 

3. In the dialog that opens, click the Remove Rule link. 

Alternately, use the Edit Rule button on the Relationships table to remove the rule. 

The rule does not appear in the Rule column. 

Filter 

Filters narrow down the objects in the Relationships tab of PSRs by the rule they contain. You can 
filter relationships with the attributes you configure using the filter option. The Relationships tab of the 
Java Client includes the Filter button. In the Web Client, use the Personalize menu to filter 
relationships. 

In the Java Client, the default View options consist of 4 values: 

All Relationships

This filter allows you to filter all the relationship objects in the table. 

Complete

This filter allows you to filter all the objects for which the rule criteria are met. 

Pending

This filter allows you to filter objects for which the rule criteria are not met. 
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Rule not specified

This filter allows you to filter objects for which there are no rules specified. 

Click the Show Filter  button. An additional row appears above the Relationships table. You can 
filter using the following attributes: 

 Criteria Met - Filters relationships where the set criteria are met. 

 Name - Filters relationships by names. 

 Description - Filters relationships by the description. 

 Rule - Filters relationships by rules. 

 Type - Filters relationships by the types.    

In the Web Client, the Views menu on the upper right helps you create views using the Personalize 
menu. The Personalize menu allows you to filter relationships. Define filter criteria based on the 
options in the Table Personalization palette. 

Additional attributes listed below help filter relationships further. 
 Criteria Met - Filters relationships where the set criteria are met. 
 Name - Filters relationships by names. 
 Description - Filters relationships by the description. 
 Current Status - Filters using the current status. 

For details on Views and Personalize menus, see the Getting Started with Agile PLM guide. 

Workflow tab of a PSR 

 process. The Workflow tab displays a flowchart of the workflow you select on the Cover 

The

1. ff information for the current status. This section is visible for review 

2. e current workflow. This section is visible for all changes 

Colo re  
ed Status 

tus 

ays past workflow and sign-off information for the PSR. For example, 

 Rule - Filters relationships by rules. 
 Type - Filters relationships by the types. 

An Agile PLM workflow is a sequence of statuses that a routable object goes through in the quality 
control
page. 

 Workflow tab page displays two sections: 

Summary - lists sign-o
or release statuses. 

Workflow - displays the chart of th
to which you assign a workflow. 

rs present the status of the workflows: 
 Green - Previous Perform
 Orange - Current sta
 Blue - Future status 

The Sign-Off History table displ
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you n 

 provide a detailed information 
  

conditions, and sort orders. You can later choose 
the required view from the list of available views. The Add Reviewers / Remove Reviewers buttons allow 

For details, see the 'Routing Objects with Workflows' chapter in the Getting Started with Agile 

Shown below is a view of the workflow statuses available for a PSR. The workflow of a Problem 
Repor

 ca route a PSR: 
 internally for preliminary investigation 
 to a manager for escalation to identify if it merits a corrective action 
 to the support call center/ field service technician who can
 to the customer for final approval of an implemented fix
 to a supplier for a response to the incident, and so on. 

The Personalize menu enables you to create and customize Views.  Use the personalize menu to 
create and save several views by defining filter 

you to add/remove Approvers and Observers. 

PLM 
guide. 

t is similar to the workflow of a Non-Conformance Report. 

         

n 
r 

anagers oversee the routing and approval process of objects, evaluate and assign 
routable objects and receive e-mail notifications. Quality Analysts are the default routing manager 

s' in the Getting Started with Agile PLM guide. 

cts. You can track and 
search attachment files and URLs, and also add files to an automatically created object called a file 

 
ta le, if a 
e es: 

 

ns allow you to add, delete, open, view, print, or get a copy of the attachment 
file. You can also check in and check out attachments (although you are actually checking file folder 

 

Submitting and Routing PSRs 

You can create routable objects from classes that represent processes. For example, a change i
the change control process, or a product service request. Route objects to Agile PLM users fo
approval via workflows. Use the Next Status button on the Cover Page of the PSR to route objects. 
Routing m

for PSRs. 

For details, see 'Routing Objects with Workflow

Attachments tab of a PSR 
An Attachment contains supportive data in the form files, documents, drawings, images. You can 
reference files and URLs from the Attachments tab of all Agile PLM obje

folder - an object of reference information from the File Folders class. 

The actual attachment files are stored in the Agile File Manager, referred to as the file vault.
At chments may contain information that describes the object or a process. For examp
sp cification describes a part or subassembly, it might have the following attachment fil

 Drawing files (such as CAD drawings) or scanned image files in viewable formats

 Files such as documents, non-viewable files, compressed (ZIP) files, and so on 

Attachments tab actio

50 Agile Product Lifecycle Management

  



 Chapter 2: Working with Product Service Requests

 

 

objects in and out). 

Note  The Personalize menu enables you to create and customize Views.  Use the personalize 
menu to create and save several views by defining filter conditions, and sort orders. You 
can later choose the required view from the list of available views. 

Also see 'Working with Attachments' chapter in the Getting Started with Agile PLM guide. 

Adding Attachment Files to a PSR 

1. Open a PSR  Attachments tab. 

To add an Attachment file to a PSR in Java Client: 

 and click the

2. Click the Add Files  button.  

3. In the File Uploader dialog, click the Browse for Files button. 

dd and double-click on it. 

7. e  

ile Folder. 
after adding. 

8. 

d files from your local disk. 

3. nload Method dialog 

/ Use Java Upload / Download tool. 

 taining the attached files is created. To add selected files in one file folder, 
dd all files to a single file folder check box, or else a file folder is created for each 

4. Cho
cted URLs in a single file folder, select the Add all URL's to a single file folder 

4. Select a file you want to a

5. Click the Options arrow.  

6. Select the Type of file from the list. 

Ch ck the following options as required:
 Unzip all zipped files upon upload. 
 Add all files to a single F
 Edit rows 

Click Upload.  

A message prompts you to delete uploade

The file appears on the Attachments table. 

To add an Attachment file to a PSR in Web Client: 

1. Open a PSR and click the Attachments tab. 

2. Select Files / URLs / By Search from the list on the Add button. 

Choose Add Files. Before the Add Files dialog appears, a File Upload and Dow
opens.  
 Select Use standard browser capabilities 
 OKClick .  
 Use the Browse button to locate files in the Add Files dialog.  

A file folder con
select the A
file selected.   

 Click .   Add
Th  filename and file folder objects appear in the Attachments table. 

ose URLs. The Add URLs dialog appears.  

e

 To add sele
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checkbox or else a separate file folder will be created for each URL. 

5. Cho l
s. You can also choose 

of the files.  
 file to the Attachments table, you can either:  

 URL. 
ed.  

 Click Add. 
The URLs and the file folder objects appear in the Attachments table. 

ose By Search. The Add Files dia og appears. 
 In the Add Files palette, enter '*' wildcard and search for files or URL

the latest version 
 To move the selected
 Drag and drop it 

Double-click the file  
 Select the file and press Enter 
 

 Enter the URL address. Alternately, you can also copy and paste an
 A table at the base displays the selected objects and corresponding files attach

 Click the Close  button or hit the Esc button to close the palette. 

The file / URL and the file folder objects appear in the Attachments table. 

 PSR 

lient: 

hments tab. 

2. 

Removing Attachment Files from a

To remove Attachment Files from a PSR in Java C

1. Open a PSR and c  the lick Attac
Select the File / URL you want to remove. 

3. Click the Remove  button.  

The File / URL no longer appears on the Attachments tab. 

nt: 

Attachments tab. 

2. 

3. Click the Remove button. 

The File / URL does not appear on the Attachments table. A message bar displays the number of 
rows removed. 

To remove Attachment Files from a PSR in Web Clie

1. Open a PSR and click the 

Select the file or URL you want to remove. 
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Chapter 3 

Working with Quality Change Requests 
In Product Quality Management, Quality Change Requests (QCR) creates and manages Audits and 
Corrective and Preventive Actions. The QCR allows you to aggregate problems into a routable quality 
record, perform an analysis of the cause of the failure and closes the problem using standard CAPA 
procedures. 

This chapter includes the following topics: 

 Creating Quality Change Requests on page 53 

 Cover Page tab of a QCR on page 57 

 Affected Items tab of a QCR on page 59 

 Relationships tab of a QCR on page 61 

 Workflow tab of a QCR on page  61

 Attachments tab of a QCR on page 63 

 Submitting and Routing a QCR on page 63 
 

e 

 s. For more details on Roles and Privileges, see the Getting Started with 
Agile PLM guide. 

You can use the  button or the  feature to create a 

1. Launch the Java Client. 

Creating QCRs 
You can create QCR objects the same way you create other Agile PLM objects. You must have th
necessary privileges to create QCRs. The Quality Administrator roles allow you to perform all the 
functions related to QCR

New Object Save As QCR.

To create a QCR in Java Client: 

2. Click the New Object  button. The New Object dialog box appears. 

4. at appears, or enter a number, or click the 
 

3. In the Type list, select a value. 

In the QCR N berum  field, accept the number th
Autonumber  button to generate a number. 

5. Click OK. 

tes the QCR object and displays the QCR (Audit or CAPA) with the Cover Page 
tab in the edit mode. 

2. 

Agile Java Client crea

To create a QCR in Web Client: 

1. Launch the Web Client.  

From the main toolbar, click the Create New drop-down button. Select Quality Change Request > 
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Audit or Corrective and Preventive Actions. The Create New dialog appears. 

fault number, enter a number, or click the Autonumber 
3. In the Type field, select a value from the list. 

QCR Number4. In the  field, accept the de

 button to generate a number. 

ode. 

to the QCR, the QCR displays the Unassigned status.   

rkflow from the Workflow list. For details, see Workflow tab of a QCR.  

he page. For example, the assigned 
status can be - Prepared, Submitted, Review, or Released. 

Note  

5. Click Save. 

Agile Web Client creates the QCR and displays it with the Cover Page tab in the edit m

If you do not assign a workflow 

To assign a workflow to the QCR: 

1. Open a QCR and click the Edit button. 

2. Select a wo

3. Click Save. 

The status of the saved QCR appears on the right corner of t

The system sends an audit reminder to the Originator and Quality Administrator before 
the audit date. If you have Modify privileges, you can configure the audit reminder date in 
the file. 

 

Creating a QCR using Save As 

ifferent class or subclass, since they may 
not include the same tabs/fields, and hence lose data.  

You can use Save As to create a QCR. The Save As feature creates a similar object with different 
values, since it copies data from a field in the existing object to the same field in the new object.  

Do not use the Save As feature to create an object in a d

Warning new object, then the If a field or list value in the existing object is not available in the 
system does not copy that field or list value to the new object.  

To create a QCR using Save As in Java Client: 

4. Open the QCR you want to use as the basis for the new QCR.  

Right-click, and choose 5. ely, choose File and select Save As from the main 

7. pears. You can also type a number or click 
umber 

Save As. Alternativ
toolbar. The Save As dialog box appears. 

6. From the Type list, select an Audit or CAPA. 

In the QCR Numb  field, accept the number that aper
the AutoN  button to generate a number. 

9. reates the QCR (Audit or CAPA) and displays the QCR with the Cover Page tab 

8. Click OK. 

Agile Java Client c
in the edit mode. 

10. Modify required fields. 
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11. Click Save to save the changes. 

To create a QCR using Save As in Web Client:   

1. Open the QCR you want to use as the basis for the new QCR.  
 drop down menu.  

fault number, enter a number, or click the Autonumber 

2. Click the Actions
3. Select Save As. 

4. In the Save As dialog that appears, select Audit or CAPA from the Type list. 

QCR Number5. In the  field, accept the de

 button to generate a number. 

ver Page in edit mode. Modify required fields. 

9 e QCR

Note  

6. Click Save. 

7. The QCR opens displaying the Co
8. Click Save to save the changes. 

. Th  appears displaying the Cover Page.  

If the Agile PLM Administrator has set the appropriate preferences, the system copies 
fields in the optional Page Two and Page Three sections to the new object. For 
information about the behavior of Page Two and Page Three fields in your Agile PLM 
system, contact your Agile PLM Administrator. Since Page Three data applies only to
specific subclass, if you use the 

 a 
a different 

subclass, the system does not copy Page Three data to the new ob
Save As feature to create a new object of 

ject. 

To enable Save As preferences for Page Two and Page Three fields, refer Admin> Server Settings> 
Preferences - Save As Page 2 for Different Classes, Save As Page 3 for Different Classes, & Save 

e Java Client. 

Creating a QCR from an Item 

R or an individual Item. When you create a QCR from an Item to drive 

change to ensure you rectify the 
he Item.  

ava Client: 

Request from the drop-down 

4. In ears, enter a number, or click the 
 

As Page 3 for Different Subclasses, in th

You can create a QCR from a PS
a problem to closure, you add: 

 the Item to the Affected Items table of the QCR. 

 the QCR to the QCRs table on the Quality tab of the Item.  

After you approve the QCR, you can route the Item through the 
defect and change to the new revision of t

To create a QCR from an Item in J

1. Open an existing an Item. 

2. Right-click in the object window and choose Create a Quality Change 
menu.  

3. Select the required sub-class Audit or CAPA from the Type list. 

the QCR N berum  field, accept the number that app
Autonumber  button to generate a number. 
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5. 

 it with the Cover Page in the edit mode. 

g the Cover Page. 

3. reate New>Quality Change Request from the drop-down menu. The Create New dialog 

5. ppears, enter a number, or click the 

Click OK. 

Agile Java Client creates the QCR and displays

To create a QCR from a PSR or an Item in Web Client: 

1. Open an existing an Item. It opens displayin

2. Click the Actions button on the Cover Page. 

Choose C
appears. 

4. Select the required sub-class (Audit or CAPA) from the Type list. 
In the QCR Number field, accept the number that a

Autonumber  button to generate a number. 

The Agile Web Client creates the QCR and displays it with the Cover Page in the edit mode. 

The QCRs you create remain in the system until you delete them. Deleting QCRs does not remove 
them from Agile database. To delete a QCR permanently from the system you need to hard-delete 

e Deleting Agile Objectsthem. For details on deleting QCRs, se  on page 73. 

Creating a QCR from a PSR 

. 
u in Web Client and the More button in Java Client. 

 the Java Client: 

Creating QCRs from PSRs allows you to tag corrective actions on to a Product Service Request
You can create a QCR using the Actions Men

To create a QCR from a PSR in

1. Open an existing PSR. 

2. Click the More  button. 

3. Select the Create Quality Change Request from the drop-down menu. 

4. A New dialog appears. Select the required sub-class Type (Audit or CAPA). 

In the QCR Number5.  the default number, enter a number, or click the Autonumber  field, accept  
enerate a number. 

c n Web Client: 

4. eate New dialog appears. Select the required sub-class (Audit or a CAPA) from the Type 

fault number, enter a number, or click the Autonumber 

button to g

6. Click OK. 

The QCR opens in the edit mode. 

 To reate a QCR from a PSR i

1. Open an existing PSR. 

2. Click the Actions menu. 

3. Select the Create Quality Change Requests option. 

A Cr
list. 

QCR5. In the  Number field, accept the de

 button to generate a number. 
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6. Click Save. 

The QCR (Audit or CAPA) opens in the edit mode. 

Cover Page tab of a QCR 
The fo d e fields on the Cover Pa CR. ge tab of a Qllowing table lists an  describes th

Field  Completed  Ind icates 

QCR Number cally, when r you assign to a QCR, when you Automati
created 

The numbe
create it.  

QCR Type cally, when f subclass you select when you create Automati
created 

The type o
the QCR. 

Category Manually ies defined by the Agile PLM A list of categor
Administrator. 

Description an 
contain a default. tes, 

 carriage returns (which 

Usually manually, c Describes the QCR. Maximum number of bytes is 
set by the Administrator; can be up to 4000 by
including spaces and
count as two bytes). 

Reason  can 
contain a default 

 and carriage returns 

Usually manually; Reason for creating the QCR. Maximum number 
of bytes is set by the Administrator; can be up to 
4000 bytes, including spaces
(which count as two bytes). 

Customer Manually. The Customer associated with the QCR. 

Supplier Manually 

e issues in the process, products or 

The list of Suppliers associated with the QCR. 

For example, Suppliers can initiate a SCAR if they 
need to resolv
other areas.  

Workflow ally. 

s in the Unassigned 

 

he 
Pending status type.  

ve this QCR 
through the quality control process.  

Usually selected manu
If you do not assign a 
Workflow to a QCR it 
remain
state. 

You are prompted to select 
a Workflow, if you move 
the QCR to the next status 
without assigning a 
Workflow. You can change
the workflow selection as 
long as the QCR is in t

The name of the workflow used to mo
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Quality 
Administrator

Select from a list. In the list, 
Departments appear first, 
followed by individual user 
names.  

The default Quality Administrator. 

Note: If you prefer another QA over default QA , 
the system displays a message " Quality 
Administrator selected is not one of the defaults. 
The default Quality Administrator list includes: 
Default QA UserName(Userid), "  

If you define the workflow to notify the default 
quality administrator, the user groups or user in 
this field receives notifications about the QCR. If 
this field is blank, then the system sends 
notifications to every quality administrator on the 
list. If the notification definition in the workflow is 
blank, the system does not send notifications. 

Status Automatically, when 
created. Updates as the 
QCR moves through the 
assigned workflows.  

Workflow status. If you do not select a workflow 
this field displays the Unassigned status.  

Originator Usually automatically, 
when created (with the 
default set by the Agile 
PLM Administrator). 

The originator or creator of the QCR. 

Date Originated Usually automatically, 
when created.  

The date you create the QCR 

Date Submitted Automatically generated 
based on workflow status.  

The date when the QCR moves to the Submitted 
status in the workflow.  

Date Released Automatically generated 
based on workflow status. 

The date when the QCR moves to the first 
released status in the workflow.  

Final Complete 
Date

Automatically when the 
QCR enters the Complete 
type status.  

The date the QCR moves to the Complete status 
type.  

Preventive Action Usually manually; can 
contain a default. 

Maximum number of bytes 
is set by the Agile PLM 
administrator; can be up to 
4000 bytes, including 
spaces and carriage 
returns (which count as two 
bytes). 

A pro-active action taken to prevent the problem 
from happening again. Applies only to CAPAs. 

Root Cause 
Analysis

Manually. 

Maximum number of bytes 
is set by the Agile PLM 
administrator; can be up to 
4000 bytes, including 
spaces and carriage 

The root cause of the problem. Applies only to 
CAPAs.  
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returns (which count as two 
bytes). 

Planned Audit Date Manually Date planned to audit the problem.  

Audit Result Usually manually, can 
contain a default. 

For example, when you  
implement a CAPA, the 
Quality Analyst performs 
an Audit to ensure the 
CAPA really solved the 
problem. If the fix for the 
problem is validated, then 
the result is pass. 
Otherwise it fails, and the 
Quality Analyst updates the 
Audit Result field. 

Audit process result. The default setting for the 
audit result is Pass/Fail. For more details on other 
settings contact the Agile Administrator. 

 

Product Line(s) Usually manually; can 
contain a default. 

List of product lines defined by the Agile 
Administrator. 

 
 

Updating the Cover Page of a QCR 

After you create a QCR, you can modify it to provide additional information you did not include when 
you created it or edit any information that has changed since its creation. 

To update the Cover Page of a QCR (Java Client and Web Client): 

1. Open the QCR you want to edit. 

2. Click the Edit button. 

3. Modify required fields. You can either enter text; use the drop-down lists or the palettes to edit 
the QCR. 

4. Click Save to save changes. 

Note  In Web Client, once you edit a QCR and save it, a message bar displays that the 
changes have been successfully saved. 

The Cover Page displays updates of the QCR. 

Affected Items tab of a QCR 
The Affected Items table lists the items affected by the QCR. The Affected Items tab of a QCR includes 
the Affected Items tables and the PSR Items tables. 

The table below lists and describes the default fields on the Affected Items tab. 
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Field  Completed  Ind icates 

Item Number Automatically, when created. Number of the Affected Item 

Item Description Automatically, when created. Description of the Item.  

Item Rev Manually  The revision of the Affected Item in which you 
find the problem.  

For example, if the Item has undergone five 
revisions, and you identify the defect in 
revision B, then the Item Rev field displays B. 

Note: You can add multiple copies of an Item 
with the same revision number to the Affected 
Items tab of a QCR. 

Affected Site Automatically, when created. The site where you find the problem.   

Image Automatically, when created. The presence of a PSR Item. 

The Affected Items tab page includes the Affected Items and the PSR Items table. The Views and 
Personalize menus appear on both these tables. 

Note  The Personalize menu enables you to create and customize Views.  Use the personalize 
menu to create and save several views by defining filter conditions, and sort orders. You 
can later choose the required view from the list of available views. 

The PSR Items table lists Items referenced by problem reports and non-conformance reports 
associated with this QCR. This table populates itself when the Relationship Rule has the QCR affect 
the PSR. 

 Associate a PSR with the QCR by adding the PSR to the QCR Relationships tab and adding a 
Rule where the QCR affects the PSR. 

 Associate a PSR with the QCR by adding the QCR to the PSR Relationships tab and adding a 
Rule where the QCR affects the PSR. 

 Create a QCR from a PSR. 

The table below lists the default fields on the PSR Item table of the Affected Items tab. 

Field  Completes  Ind icates 

Item Number Automatically, when created Number of the Affected Item 

Item Description Automatically, when created Describes the Item 

Item Rev Manually The revision of the Affected Item in which you 
find the problem. 

Affected Site Automatically, when created The site at which you find the problem. 

PSR Number Automatically, when created The number of the PSR associated with the 
QCR. 

Note  The Item Number field indicates the  Ascending or  Descending order of the table, 
depending on the sort order you choose in the Personalize menu. 
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Relationships tab of a QCR 
The Relationships tab allows you to create relationships and dependencies between the current QCR 
and other routable/ lifecycle objects. 

When you create a QCR from a PSR the system copies the: 

 PSR to the Relationships table of the QCR. 

 QCR to the Relationships table of the PSR. 

You can set the event trigger to move the PSR to a specific status in the workflow when the QCR 
event occurs. 

The Relationships tab of a QCR is similar to that of a PSR. See also: Relationships tab on page 38. 

For details, see the Getting Started with Agile PLM guide. 

Workflow tab of a QCR 
The Workflow tab displays a flowchart of the workflow you selected on the Cover Page. An Agile PLM 
workflow is a sequence of statuses that a routable object follows as it goes through the different 
statuses in quality control process. The status with the orange background (Web Client) or the 
yellow background (Java Client) is the current status. The Signoff History table displays past 
workflow and signoff information for the QCR. 

The Workflow tab page includes the Views and Personalize buttons. For details on Views and 
Personalize menus, see the Getting Started with Agile PLM guide. 

Note  Notice that the Default Audits and Default CAPAs workflow statuses are different from 
those for other routable objects. 
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The status of the audit workflow begins with Prepared state and that of the CAPA with the Identified 
state. 

 

 

The table below represents the status of a default CAPA. 

 

62 Agile Product Lifecycle Management

  



 Chapter 3: Working with Quality Change Requests

 

 

For details, see the 'Routing objects with Workflows' chapter in the Getting Started with Agile PLM 
guide. 

Submitting and Routing a QCR 

You can submit QCRs using the Next Status button. The process is the same as for submitting other 
routable objects. Before switching the QCR to a different status, always audit the routable object to 
detect any errors that may prevent switching to a different status. When you submit a QCR, you also 
notify the Quality Administrator by email. The Quality Administrator can also use the defined 
searches in the Workflow Routings area of the Inbox or the Quality Searches folder to find recently 
submitted QCRs. 

For details, see 'Routing Objects with Workflows' in the Getting Started with Agile PLM guide 

Attachments tab of a QCR 
You can reference files and attachments from the Attachments tab of a QCR. The Attachments tab of a 
QCR is similar to that of the PSR. For details, see Attachments tab of a PSR on page 50. 
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Chapter 4 

Managing Product Service Requests 

This chapter includes the following: 

 Approving /Rejecting a Product Service Request................................................................................................ 65 
 Closing a PSR ..................................................................................................................................................... 66 
 Actions menu in PSR........................................................................................................................................... 66 
 Audit Status of a PSR.......................................................................................................................................... 67 
 Audit Release of a PSR....................................................................................................................................... 67 

This chapter includes the following topics: 

 Approving/Rejecting a Product Service Request on page 65 

 Closing a PSR on page 66 

 Actions Menu in a PSR on page 66 

 Audit status of a PSR on page 67 

 Audit Release of a PSR on page  67
 

Approving /Rejecting a Product Service Request 
To approve or reject a PSR, you must be an Approver for the PSR and hold the PSR Administrator 
role. See your Agile Administrator if you need additional privileges. 

To approve a PSR: 

1. Open a PSR. (Ensure that it is in the Review or Released status). 

2. Click the Approve button above the tabs. The Approve to Review dialog appears.  

3. Notice that the User field is pre-populated. 

4. Enter Password spe s field is mandatory. as the User cified. Thi

5. Select the Quality Analyst and Originator you want to notify. 
Reviewers.  6. Use the palette to add 

7. Add Comments, if any. 

8. Select the Send notification as urgent check box to mark the notification sent out because of this 
action as "Urgent". 

9. Click Approve. 

10. Click Finish. 

To reject a PSR: 

1. Open a PSR. (Ensure that it is in the Review or Released status). 
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2. Click the Reject button above the tabs. The Reject for Review dialog appears. 

datory. 

nator you want to notify. 

Reviewers. 

7. ication as urgent check box to mark the notification sent out as a result of this 

ct button. 

9. Click Finish. 

Closing a PSR 
 cl

 Set a  on the ps tab of the PSR so that the status of the PSR is Closed on meeting 

 perform on the PSR such as: 

ves a copy of the current PSR in the same or a different subclass. 

• ry Roles and Privileges. Option to 

•  Clipboard: Copies the URL of the object to the clipboard, so that you can paste it 

er.   

workflow status. 

s you to view the workflow states of the PSR. 

L file. 

3. Enter Password to enter as the User specified. This field is man

4. Select the Quality Analyst and the Origi
5. Use the palette to add 

6. Add Comments, if any. 

Select the Send notif
action as "Urgent". 

8. Click the Reje

 

To ose a PSR (promote a PSR to the Complete status):  

 Close it manually (provided you have the appropriate privileges). 

Rule Relationshi
the conditions of that rule. 

 

Actions menu in PSR 
The Actions menu provides you with a list of actions that you can

• Bookmark: Saves the PSR as a Bookmark for future retrieval. 

• Subscribe: Subscriptions notify you of changes on tables or of attributes on the objects. 

• Save As: Creates and sa

• Delete: Deletes the PSR 

Send: Sends the PSR to other Users who have the necessa
send the notification as urgent available. 

• Sharing: Allows Users to grant other users privilege access equivalent to his. 

Copy URL to
elsewhere. 

• Audit Status: Audits the status of an object to check if the workflow can progress furth

• Audit Release: Audits if the object can be released with the existing 

• View Workflows: Allow

• Print: Prints the PSR 

• Export: Exports the PSR to a delimited text file (CSV), a Microsoft Excel Notebook, or an XM
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• Create Quality Change Requests: Allows you to create Quality Change Requests on the PSR. 

Audits the status of a PSR, to check if the workflow can move to the next state. It is performed 
SR has to autopromote to the next state. 

ent: 

 from the menu 

Results for Audit Status dialog box appears. Correct errors, if any.  

nt: 

ar displays the message to correct errors if any. 

An Audit Release is performed automatically when the PSR is promoted to the release state. The Audit 
ettings. 

. If you set the 
AutoPromote property of the preceding Review status type to Yes, then you release the routable 

Befo the audit release. The system will validate 

rent status level. (Your Agile Administrator determines the required fields 
ettings.) 

overs. 

For details on how to release a PSR, see the 'Routing Objects with Workflows' chapter in the Getting 

Audit Status of a PSR 

automatically when the workflow of the P

To audit the status of a PSR in Java Cli

1. Open a PSR you need to audit. 

2. Click the Audit button at the top or right-click in the window; choose Audit Status
that appears. 

3. The Audit 

4. Click OK. 

To audit the status of a PSR in Web Clie

1. Open a PSR you need to audit. 

2. Click the Actions menu and choose Audit Status. 

3. A message b

4. Click Close. 
 

Audit Release of a PSR 

Release validates if the settings of a PSR match Release status s

(For example: Entry Required fields, Status matching criteria) 

You can release a PSR by using the Next Status button on the Workflow tab

object (automatically when all the approvers have approved the change). 

re you release a PSR, you need to audit it and pass 
the following audit for each status level: 

 For the Pending, Review, Released, and Complete status: 

Required fields for the cur
in the workflow property s

 For the Review status: 

Checks approval of all Appr

 For the Released status: 

Checks all the current release audit rules. 
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Started with Agile PLM guide.

To audit the PSR for release in Java Client: 

1. Open the PSR you want to audit for release. 

Click the 2.  that 
it Results for Audit Release dialog box appears. 

alog box. 

 for release. 

s, if any and audit again. 

. Click Close. 
 

Audit Release button or right-click in the Agile Java Client window; from the menu
appears, choose Audit Release. The Aud

3. Correct errors, if any and audit again. 

4. Click OK to close the Audit Results di

To audit the PSR for release in Web Client: 

1. Open the PSR you want to audit

2. Choose Actions > Audit Release. 

3. Correct error

4
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Chapter 5 

Managing QCRs 

This chapter includes the following: 

 Approving/Rejecting Quality Change Requests................................................................................................... 69 
 Closing a QCR..................................................................................................................................................... 70 
 Actions Menu in a QCR ....................................................................................................................................... 70 

This chapter includes the following topics: 

 Approving/Rejecting Quality Change Requests on page 69 

 Closing a QCR on page 70 

 Actions Menu in a QCR on page 70 

 Change Order in a QCR on page 71 
 

 You need to be on the QCRs list as an approver or observer  

ears. 

  

e QCR. 

7. ments are not mandatory. You need to 

 'Workflow' the Agile PLM Administrator guide. 

8. Click . 

ager, and feel 
the corrective action taken by your team is not appropriate, you can reject the action. 

Approving/Rejecting Quality Change Requests 
If the QCR specifies you as an Approver, then you have to verify the audit or corrective action for a 
specific item. For details, see the Getting Started with Agile PLM guide. 

You need to hold necessary privileges and meet the following conditions to approve/reject a QCR. 

 The QCR needs to be in review or released type status 

 You need the necessary privilege to approve/reject it in that status 

To approve a QCR in the Web Client: 

1. Open the QCR you want to approve.  

2. Click the Approve button. The Approve wizard app

3. In the Password field, enter your password. 

4. Select the check boxes to notify the Originator, Quality Analyst, and Reviewers.
5. You can also notify users or user groups that you have approved th

6. Click the Search palette and select the users you want to notify. 

In the Comments field, enter approver comments. Com
set Comments for Rejection to Allow in the Java Client. 

For details, see

Approve

You can reject QCRs if they are not appropriate. For example, if you are a Quality Man
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To reject a QCR in the Web Client: 

1. Open the QCR you want to reject.  

2. Click the Reject button. The Reject wizard appears. 

3. In the Password field, enter your password. 

4. Select the check boxes to notify the Originator, Quality Analyst, and Reviewers. 
5. Click the Search palette to select users you want to notify. 

6. In the Comments field, enter Approver comments. Comments are not mandatory. You need to 
set Comments for Rejection to Allow in the Java Client.  

For details, see 'Workflow' the Agile PLM Administrator guide. 

7. Click the Reject button. 
 

Closing a QCR 
To close a QCR (promote a QCR to the Complete status): 

 Close it manually (provided you have the appropriate privileges).  

 Set a Rule on Relationships tab of the QCR so that the status of the QCR is Closed on meeting the 
conditions of that rule. 

Typically, when you release a Change or an ECO related to a QCR, the Quality Administrator 
determines if you can resolve and close a QCR.

Actions Menu in a QCR 
The Actions Menu provides you with a list of actions that you can perform on the QCR such as: 

• Bookmark: Saves the QCR as a Bookmark for future retrieval. 

• Subscribe: Subscriptions notify you of changes on tables or of attributes on the objects. 

• Save As: Creates and saves a copy of the current object in the same or different subclass. 

• Delete: Deletes the QCR. 

• Copy URL to Clipboard: Copies the URL of the object to the clipboard, so that you can paste it 
elsewhere. 

• Audit Status: Audits the status of an object to check if the workflow can progress further.  

• Audit Release: Audits if the object can be released with the existing workflow status. 

• Print: Prints the QCR. 

• Export: Exports the QCR to a delimited text file (CSV), Microsoft Excel Workbook or to an XML file. 

• Send: Sends the QCR to other Users who have the necessary Roles and Privileges. Option to 
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send the notification as urgent available. 

• Sharing: Allows Users to grant other users privilege access equivalent to his.  

• Create Change: Allows you to create a Change directly from the QCR. 

• View Workflows: Allows you to view the workflow states of a QCR. 

Change Order in a QCR 

You can create a change directly from the QCR, which allows you to release a change order to fix 
the problem. The Change you create from the QCR appears in the Relationships tab of the QCR. 

To create a Change from a QCR in Java Client: 

1. In the Cover Page of a QCR, right-click and select Create Change. 

2. Select a Change object type from the Type list. You can select MCO, ECO, ECR, Deviation, or 
Stop Ship. 

3. In the Number field, type a number or click the AutoNumber  button to generate a number. 

4. The Add Affected Items to Change table lists all Affected Items of QCR and PSR. Select 
item(s) from the list of Affected Items and PSR Items. If an Item is already associated with a 
Change, it still appears in this list so that you can initiate multiple changes related to one Item. 
The list will only show unique items (if the same item shows up in the Affected Items and PSR 
Items, then the list will only display that item once). 

5. Click OK. 

Agile Java Client creates the Change and adds it to the Relationships tab of the QCR. The system 
copies the Items selected to the Affected Items tab of the Change (This allows you to separate the 
QCR into multiple Changes, each containing different Items). 

To create a Change from a QCR in Web Client: 

1. Open the QCR and select Actions | Create Change menu option. 

2. In the Create New dialog, select a Change object type from the sub-class list. You can select 
MCO, ECO, ECR, Deviation, or Stop Ship. 

3. In the Number field, type a number or click the Autonumber  button to generate a number. 

4. The Date Originated field is pre-populated. 

5. Click the Search palette to add Versions. 

6. Use the Search palette to add Affected Items. Select and double-click an object to move it to the 
Affected Items field. 

7. Click Close. 

8. Click Save. 

Agile Web Client creates the Change and adds it to the Relationships tab of the QCR. The system 
copies the items selected to the Affected Items tab of the Change (This allows you to separate the QCR 
into multiple Changes, each containing different Items). 
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Appendix A 

Deleting Agile Objects 
Java Client and Web Client support “soft” and “hard” deletes for many Agile object classes. When 
you soft-delete an object in the database, it is not permanently deleted. A soft-deleted object is 
marked “Deleted” in the database, and its object number or name is reserved. You cannot create 
another object with the same type and number or name as a soft-deleted object. 

When you run a search, soft-deleted objects do not appear in the search results table. To locate 
soft-deleted objects, you must run the predefined deleted object searches in the Recycle Bin Searches 
folder. 

Note  You have access to the Recycle Bin Searches folder if Recycle Bin Searches is included in the 
Searches field of your user profile. If you have the appropriate privileges, you can edit 
your user profile and add Recycle Bin Searches to the list of searches in the Searches field. 
If you do not have the appropriate privileges to modify the Searches field in your user 
profile, ask the Agile administrator to modify your user profile. 

A hard-deleted object is permanently removed from the database. 

Caution You cannot undelete a hard-deleted object. 

In order to soft-delete, hard-delete or undelete an Agile object: 

 You must have the appropriate Delete or Undelete privileges for that object. 

 All relationships and subscriptions must be removed. 

 The object must meet any additional conditions that determine whether it can be deleted or 
undeleted. 

In general, if deleting or undeleting an object would cause the compromise of data integrity, the 
delete or undelete action is disabled. 

Notes about Deleting PSR or QCR Objects 
Before you can delete a Product Service Request (PSR) or Quality Change Request (QCR) object, 
it must meet the conditions described below. 

 The Agile administrator has assigned to you a role that has the appropriate Delete privileges. 

 All relationships and subscriptions have been removed. 

 The PSR or QCR is at the Pending status type or the Unassigned status. 

ges for any items on the Affected Items table; otherwise, 
you cannot delete the PSR or QCR. 

 You have Discovery and Read privile
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Note  To delete a PSR or QCR that has already been released, you must first unrelease it. You 
need the appropriate privileges to unrelease a PSR or QCR by using the Workflow tab to 
switch it to a different status. 

You cannot delete a PSR if: 

 It appears on a QCR's Relationships tab. 

 It is currently part of a corrective action process. Remove the PSR from the QCR and then 
delete the PSR. 

 It appears in the Related PSR tab of another PSR. 

 It is currently part of a larger problem. Remove this PSR from the parent PSR and then delete 
it. 

 It appears on the Related PSR tab. 

 It is being used to aggregate multiple problems. Remove the related PSRs and then delete it. 

You cannot delete a QCR if: 

 process contains Problem Reports. Remove the PSR from the QCR and 

 ough engineering changes. Remove the 

 It has any PSRs on the Relationships tab. 

If the corrective action 
then delete the QCR. 

 It has any Changes on its Relationships tab. 

If the corrective action process is already routed thr
Changes from the QCR and then delete the QCR. 

 

This section contains the following topics: 

 Soft-Deleting an Object on page 74 

 Undeleting an Object on page 75 

 Hard-Deleting an Object on page 75 
 

Soft-Deleting an Object 
ntil it is hard-deleted, its 

gile database and cannot be reused. 
When an object is soft-deleted, it is no longer available for use. However, u
number or name is reserved in the A

To soft-delete an object in Java Client: 

1. Select and open the ob t you want to delete. jec

2. Click the Delete button , and respond Yes to the confirmation prompt. 

The object is soft-deleted. 

To soft-delete an object in Web Client: 

1. Select and open the object you want to delete. 
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2. Choose Actions > Delete, and respond OK to the confirmation prompt. 

leting Agile Objects, Undeleting an Object

The object is soft-deleted. 

See also: De  on page 75, and Hard-Deleting an Object 
on page 75. 

Undeleting an Object 
es, you can undelete soft-deleted objects. 

 from the Recycle Bin Searches folder. 

ant to restore. 

If you have the appropriate privileg

To undelete an object in Java Client: 

1. Run the appropriate Deleted <objects> search

2. Open the deleted object y  wou

3. Click the Undelete button . 
 

To undelete an object in Web Client: 

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder. 

u want to restore. 

3. Choose 

Note  lts table to display the search result 

2. Open the deleted object yo

Actions > Undelete. 

You can click the Navigator button in the search resu
 NAVIGATOR drawer. object links in the left pane 

 

See also: Deleting Agile Objects, Soft-Deleting an Object on page 74, and Hard-Deleting an 
Object on page 75. 

Hard-Deleting an Object 

ou can undelete it. Run the appropriate Deleted 

te Deleted <objects> search from the Recycle Bin Searches folder. 

Soft-deleted objects still exist in the database. To remove an object permanently, you must hard-
delete it. While an object is still only soft-deleted, y
object search from the Recycle Bin Searches folder. 

To hard-delete a soft-deleted object (if you have the appropriate privileges) in Java Client: 

1. Run the appropria

2. Open the object. 

3. Click the Delete Object button , and respond Yes to the confirmation prompt. 
 

To hard-delete a soft-deleted object (if you have the appropriate privileges) in Web Client: 

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder. 

object rows in the search results table. 2. Select the one or more 

3. Click the Delete button. 
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4. In response to the warning prompt, choose Continue, then click Finish. 

5. e one object at a time: 

C

Note  lts table to display the search results 

Or, you can hard-delet
 Open the object. 
 hoose Actions > Delete, and respond OK to the confirmation prompt. 

You can click the Navigator button in the search resu
object links in the left pane  drawer. NAVIGATOR 

 

ee also: DeS leting Agile Objects, Undeleting an Object on page 75, and Soft-Deleting an Object 
n page 74. 

 
o
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